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Вступление 
 

Данная книга включает теоретический минимум по созданию 
макета книги. Здесь будут рассмотрены лишь основные правила 
оформления книги и некоторые программные инструменты, которые 
понадобятся Вам в процессе верстки. 

С помощью MS Word мы попробуем заверстать текст, формулы и 
таблицы. 

Еще раз замечу, что данная книга не является самоучителем по MS 
Word 2003, 2007, 2010. Мы разберем лишь основные элементы, которые 
является лишь незначительной частью данного программного продукта. 
Для более детального изучения стандартов и программ вы можете 
воспользоваться ресурсами Интернета, который богат на данные 
уроки. 

Ну что ж, начнем... 
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Теоретический минимум 
 

В какой бы программе Вы не верстали, есть некоторые правила, 
которые будут применяться абсолютно во всех этих программах. О 
них и поговорим. 

Если Вы пренебрегаете общепринятыми правилами или же просто-
напросто ленитесь читать данный раздел, запомните самое важное из 
всех этих правил и ни при каких условиях не нарушайте его. 

  

Какой стиль оформления вы бы не выбрали, придерживайтесь его
на протяжении всей книги. 

  
Это значит, что по всему документу должны быть одинаково 

оформлены заголовки, колонтитулы, отступы красной строки, списки 
и т.д., включая даже кавычки и апострофы... 

А теперь перейдем к правилам. 
 
Создание книги можно разделить на несколько этапов: 
1. Набор текста в электронном виде и подбор иллюстраций. 
2. Корректура и редактирование. 
3. Внесение правок. 
4. Верстка. 
5. Сверка. Согласование сигнального варианта книги с автором. 
6. Техническая корректура. 
7. Последняя правка, вывод макета для передачи на печать. 
8. Создание обложки. 
Набор текста мы, конечно же, рассматривать не будем, поскольку в 

издательство приносят уже набранные тексты. Не будем рассматривать мы 
в полном объеме и корректуру, поскольку она не входит в обязанности 
верстальщика. Однако есть некоторые моменты, которые необходимо 
знать... 

Подготовка текста 

Перед тем, как приступить к верстке, «чистим» текст. 
Первым делом исправляем орфографические и прочие ошибки – 

вносим правки, сделанные редактором (см. Приложение 1. Коррек-
турные знаки). 
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На следующем шаге убираем все лишние символы: 
– лишние пробелы; 
– пробелы в конце абзаца; 
– пробелы в начале абзаца; 
– мягкие переносы; 
– знаки табуляции (в некоторых случаях); 
– пробелы перед знаками пунктуации (перед запятой, точкой, 

многоточием, восклицательным знаком, точкой с запятой, двоеточием, 
вопросительным знаком, закрывающейся скобкой). Исключением 
являются № и %, они пишутся с пробелом; 

–  пробелы после открывающейся скобкой. 
Необходимо различать дефисы и тире: дефисы пишутся без пробелов, 

тире – с пробелами. В тексте не должно быть длинных тире (–). 
Также необходимо убрать разрывы строк. 
И последнее. По всему тексту должны быть одинаковые кавычки и 

апострофы. Как правило, в книгах используются «кавычки-елочки». 
См. также Приложение 2. Некоторые символы ASCII. 

Создание макета 

Как правило, книги имеют формат A5 или А5+ (он же B5) (см. 
Приложение 3. Форматы бумаги). 

Поля в книге должны выставляться с учетом того, что слева будет 
переплет, а сверху, справа и снизу наша книга будет подрезаться. 
Поэтому выставим поля порядка 2 см каждое, если книга имеет до 200 
страниц, или же увеличиваем внутреннее поле до 2,5-3 см, если книга 
имеет более 200 страниц. 

Первая страница 

Первая страница непериодического издания включает в себя 
надзаголовочные данные, имя автора (авторов), заглавие издания; 
подзаголовочные данные (вид издания, герб издательства, имя 
издателя или название издательства, место и год выпуска). Структура 
первой страницы представлена на рис. 1. 

Надзаголовочные данные книжного издания содержат: наимено-
вание организации, от имени или при участии которой выпускается 
издание (как показано в примере). 

Имя автора приводят в форме, которая установлена автором или 
издателем. Имена соавторов приводят в принятой ими последова-
тельности. 
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Рис. 1. Структура титульной страницы непериодического издания: 

1 – надзаголовочные данные; 2 – имя автора (авторов); 3 – заглавие издания; 4 – 
подзаголовочные данные (вид издания); 5 – подзаголовочные данные: 5.1 – герб 

издательства; 5.2 – имя издателя (название издательства); 5.3 – место и год выпуска 

 
Заглавие издания приводят в том виде, в котором оно установлено 

автором или издателем. 
Подзаголовочные данные книжного издания содержат сведения: 

поясняющие заглавие; о виде издания, жанре произведения, читатель-
ском адресе и целевом назначении издания; об утверждении издания в 
качестве учебного пособия, учебника или официального издания; о 
языке текста, с которого переведено произведение, и имени переводчика; 
о составителе, ответственном (научном) редакторе, авторе предисловия, 
послесловия, комментариев, переводчике, иллюстраторе, других лицах, 
принимавших участие в создании издания; о повторности издания 
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(переиздании); о том, что издание является переработанным, дополненным, 
исправленным, адаптированным, стереотипным, репринтным или 
факсимильным; имя издателя; место выпуска издания; год выпуска 
издания. Место выпуска издания указывают в именительном падеже. 
Имя издателя приводят во всех изданиях в единообразной форме. Год 
выпуска издания приводят арабскими цифрами без слова «год» или 
сокращения «г.».  

 
Первая страница периодического издания включает в себя 

международный стандартный номер сериального издания (ISSN); 
надзаголовочные данные; заглавие издания, частное заглавие выпуска; 
подзаголовочные данные. 

Международный стандартный номер сериального издания (ISSN) 
приводят в правом верхнем углу на обложке или титульном листе. 

Надзаголовочные данные, заглавие издания периодического издания 
оформляются так же, как и в непериодическом издании. 

Номер выпуска и тома приводятся под заглавием издания. 
Подзаголовочные данные периодического издания оформляются 

аналогично подзаголовочным данным непериодического издания. 
 

Титульный лист входит в общую нумерацию страниц, однако 
номер страницы на нем не ставится. 

Вторая страница 

Вторая страница включает в себя классификационные индексы 
(УДК, ББК, авторский знак), макет аннотированной каталожной 
карточки (библиографическое описание, аннотацию, ISBN, знак охраны 
авторского права). Вторая страница научного издания также включает в 
себя данные о протоколах (кафедры, ученого совета университета, 
Министерства образования и науки) и рецензентах издания. Структура 
второй страницы приведена на рис. 2. 

Классификационные индексы содержат:  
– индекс Универсальной десятичной классификации (УДК); 
– индекс Библиотечно-библиографической классификации (ББК). 
Классификационный индекс УДК определяют по полному изданию 

Универсальной десятичной классификации. Классификационный индекс 
ББК – по изданию «Библиотечно-библиографическая классификация. 
Таблицы для массовых библиотек». 

Классификационные индексы приводят вместе с соответству-
ющими аббревиатурами УДК, ББК в верхнем левом углу оборота 
титульного листа. 
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Рис. 2. Структура второй страницы: 

1 – классификационные индексы: 1.1 – универсальный десятичный индекс; 
1.2 – библиотечно-библиографический индекс; 1.3 – авторский знак; 

2 – данные для научной литературы: 2.1 – протоколы; 2.2 – рецензенты; 
3 – макет аннотированной каталожной карточки: 3.1 – библиографическое описание; 
3.2 – аннотация; 3.3 – международный стандартный номер книги (ISBN); 3.4 – знак 

охраны авторского права 

 
Авторский знак определяют по двузначным таблицам авторских 

знаков Л. Б. Хавкиной. Авторский знак приводят под первой цифрой 
индекса ББК. 

Протоколы. Научная литература должна содержать следующие 
протоколы: 

– методическая серия и монографии: протокол кафедры (необя-
зательно), протокол ученого совета университета; 
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– пособия: письмо из Министерства образования и науки Украины, 
протокол кафедры (необязательно), протокол ученого совета университета. 

Рецензенты. Любая научная литература должна иметь сведения о 
рецензентах (ФИО, звание, должность и т.д.). 

Библиографическое описание имеет следующую структуру: 
– для непериодических изданий: 

Фамилия и инициалы автора (или первого из авторов, если их 
несколько) 

Название издания : вид издания / инициалы и фамилии всех авторов 
(если их несколько) ; [инициалы и фамилия распорядителей, ред. 
коллегии и т.д.]. – Город : название издательства, год издания. – 
Количество страниц; 

– для периодических изданий: 

Фамилия и инициалы автора (или первого из авторов, если их 
несколько) 

Название издания : вид издания / инициалы и фамилии всех авторов 
(если их несколько) ; [инициалы и фамилия распорядителей, ред. 
коллегии и т.д.]. – Город : название издательства, год издания. – 
Выпуск. Том. – Количество страниц. – (Название серии). 

Аннотация. Любая книга в обязательном прядке содержит анно-
тацию, которая может быть оформлена шрифтом более мелкого размера. 

Международный стандартный номер книги (ISBN) указывают в 
нижнем левом углу оборота титульного листа непериодического издания. 

Знак охраны авторского права приводят в нижнем правом углу 
оборота титульного листа. 

Оглавление 

Оглавление – обязательный элемент любой книги. 
По месту расположения различают предтекстовое и затекстовое 

оглавление, т.е. в начале книги и в конце книги. 
По форме представления оглавления бывают таблично-выводными (с 

заголовками в боковике и номерами страниц в одной или нескольких 
графах), перечневыми (заголовки-новострочия, а номера страниц – в 
подбор к ним), перечнево-текстовое (заголовки и номера страниц в 
подбор один комплекс к другому). 

По графической структуре различают оглавление прямое (заголовки 
предшествуют ссылкам на страницы) и обратное (ссылки на номера 
страниц предшествуют заголовкам). 
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По степени графической различимости заголовков разных ступеней 
рубрикации оглавления подразделяются на выделительно-шрифтовые 
(соподчиненность заголовков выражена шрифтами разных гарнитур, 
кеглей и начертаний), выделительно-нешрифтовые (соподчиненность 
заголовков выражена отступами, выключкой, линейками, знаками и 
т. п.), выделительно-комбинированные (соподчиненность выражена 
шрифтовыми и нешрифтовыми приемами). 

Рекомендуется все же размещать оглавление в начале книги. 
Каждый заголовок будем писать с новой строки и через линию из 
точек номера страниц, с которых эти заголовки начинаются. Само 
графическое оформление остается на вкус верстальщика. 

Колонтитулы 

В качестве колонтитулов в обязательном порядке выступают 
номера страниц. Они могут располагаться в верхнем или нижнем 
колонтитуле, снаружи или по центру. 

Также в колонтитулах можно поместить текст. Это может быть имя 
автора, название книги, название разделов, глав и т.д. 

Как правило, на странице, где указано заглавие нового раздела, 
верхний колонтитул убирается. Колонтитулы также не ставятся на 
первой, второй, последней страницах, страницах для заметок (об этом 
чуть позже). 

Содержимое 

Вот мы и добрались до текста. Начнем с заголовков. 
 
Заголовки 
Заголовки и подзаголовки в тексте необходимо визуально выделять. Это 

можно сделать, выбрав другую гарнитуру (для заголовков лучше 
выбирать шрифт без засечек, например, Arial Black, Franklin Gothic 
Demi), другой размер шрифта (16-20 пт), другое начертание (под-
заголовки часто просто выделяют жирным шрифтом, курсивом или 
жирным курсивом), выделив заголовки заглавными буквами или же 
отделив заголовок от основного текста каким-нибудь графическим 
элементом. В общем, здесь есть, где разгуляться фантазии. Однако не 
переборщите с изобилием гарнитур. Помните одно из основных правил 
дизайна, нежелательно, чтобы в макете использовалось более трех 
шрифтов. 

Выравнивать заголовки (по левому краю, по центру и по правому 
краю) можете на свое усмотрение. 
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Рекомендуется отступ перед заголовком делать большим, чем 
отступ после заголовка. Так вы покажете принадлежность данного 
заголовка к нижеследующему тексту. 

 
Основной текст 
В книжной верстке для основного текста, как правило, используется 

шрифт с засечками (Times New Roman regular (обычный), Bodoni regular 
(обычный)) размером 10 пт и одинарным междустрочным интервалам. 

Для выделения отдельных фрагментов, текст используется жирное 
начертание шрифта, жирный курсив или просто курсив. Не 
рекомендуется использовать подчеркнутый текст. 

Следующий момент. Недопустимо, чтобы между словами были 
слишком большое расстояние. Это можно исправить с помощью 
уплотнения или разрежения межбуквенного расстояния. 

Таким же способом можно устранять висячие символы. Что 
считается висячими символами? «Висячими» можно считать: 

– № в конце строки, число в начале следующей строки; 
– число в конце строки, % в начале следующей строки; 
– число в конце строки, единица измерения в начале следующей 

строки; 
– число в конце строки, г. или ст. в начале следующей строки; 
– фамилия на одной строке, инициалы на другой и т.д. 
Выравнивание текста по левому или правому краю несколько 

затрудняет чтение, поэтому основной текст должен быть выровнен по 
ширине страницы. Исключением могут быть заголовки. 

Каждый абзац должен начинаться с красной строки. Зададим 
отступ красной около 0,5-0,7 см. 

Отступы перед абзацем и после абзаца желательно не делать. 
Исключением может являться случай, когда абзацы не имеют отступов 
красной строки. 

Междустрочное расстояние рекомендуется делать в один интервал. 
С помощью междустрочного интервала (немного уменьшив его или 

увеличив) можно также избавляться от висячих строк. Висячие строки – 
это первая строка абзаца в конце страницы и последняя строка абзаца в 
начале страницы. 

 
Списки 
В тексте книги можно использовать как нумерованные, так и 

маркированные списки. Для нумерованных списков, как правило, 
используются арабские цифры, для маркированных – тире. 

Текст списка форматируется так же, как и основной текст. 
Единственным исключением является то, что красная строка списка 
может начинаться не с отступа, а с выступа. 
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И еще несколько важных моментов: 
– каждый элемент списка должен заканчиваться знаком пунктуации: 

точкой или точкой с запятой; 
– если в конце элемента стоит точка с запятой, то следующий 

элемент не может начинаться с заглавной буквы; соответственно, если 
элемент списка заканчивается точкой, то следующий элемент не может 
начинаться с строчной буквы; 

– в нумерованных списках, если после порядкового номера элемента 
списка стоит точка, новый элемент должен начинаться с заглавной 
буквы; если же после порядкового номера элемента списка стоит скобка, 
новый элемент списка должен начинаться со строчной буквы. 

 
Сноски 
Иногда текст книги содержит сноски. 
Знак сноски представляет собой надстрочный знак (верхний индекс) 

и может обозначаться как числом (арабским или римским), так и символом 
(звездочка, буква алфавита...). 

Сноски обычно набирают шрифтом пониженного кегля по 
сравнению со шрифтом основного текста (в нашем случае, если размер 
основного текста 10 пт, то текст сноски 8 пт) и отделяют от него пробелом 
или пробелом с тонкой короткой линейкой (линией). 

Сноску, как правило, располагают на той же странице, что и фрагмент 
основного текста, к которому она относится. 

Если сноска не умещается на одной странице, то не уместившуюся 
часть ее переносят на следующую страницу, размещая над сносками к 
этой странице, и не ставят перед продолжением сноски знака сноски. При 
этом не забываем, что не должно быть «висячих» строк. Нежелательно 
также, чтобы первая часть сноски заканчивалась точкой – знаком завер-
шения предложения: читатель может посчитать, что сноска закончилась, 
и продолжит чтение основного текста, не познакомившись со всей 
сноской. 

 
Специальные символы 
К специальным символам относятся те символы, которых нет на 

клавиатуре. Ими могут быть: 
– буквы греческого алфавита (ζ, λ, π); 
– кириллица (Ґ, ґ); 
– знаки пунктуации (‰, ‹, ›, ‼); 
– денежные единицы (₤, €); 
– буквоподобные символы (™); 
– числовые формы (⅓, ⅛, ⅞); 
– стрелки (←, ↑, ↔, ↕); 
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– математические операторы (±, ≠, ≤, ≥); 
– непечатные знаки (¤, ¶); 
– и прочее (©, ®). 
Буквы греческого алфавита лучше выделять курсивом (из личного 

опыта). 
Как с ними работать, мы рассмотрим в главах, посвященным 

определенным программам для верстки. 
 
Формулы 
Формулы размещают непосредственно после текста, в котором они 

упоминаются, посредине страницы. 
Выше и ниже формулы должно быть оставлено не меньше одной 

свободной строки. 
Номер формулы состоит из номера раздела и порядкового номера 

формулы, разделенных точной. Например, формула (1.3) – третья 
формула первого раздела. 

Номер формулы указывают на уровне формулы в скобках в правом 
крайнем положении на строке. 

Пояснение значений символов и числовых коэффициентов, входящих 
в формулу, необходимо приводить непосредственно под формулой в той 
последовательности, в которой они приведены в формуле. 

Пояснение значения каждого символа и числового коэффициента 
следует давать с новой строки. Первую строка пояснения начинают с 
абзаца словом «где» без двоеточия. 

Переносить формулы на следующую строку допускается только на 
знаках выполняемых операций, повторяя знак операции в начале 
следующей строки. 

Формулы, идущие одна за другой и не разделенные текстом, 
отделяются запятой или точкой с запятой. 

 
Рисунки 
Рисунки следует размещать непосредственно после текста, где они 

упоминаются впервые, или на следующей странице.  
Выше и ниже рисунка с подписью должно быть оставлено не 

меньше одной свободной строки. 
На все рисунки должны быть посылания в тексте. 
Под каждым рисунком должна быть подпись, состоящая из: 
– наименования графического сюжета, которое обозначается 

сокращением «Рис.»; 
– порядкового номера рисунка, который указывается без знака 

номера арабскими цифрами и состоит из номера раздела и порядкового 
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номера рисунка, разделенных точкой; если после номера следует 
название рисунка, то после номера ставим точку; 

– тематического заголовка; 
– экспликации, которая строится следующим образом: детали сюжета 

обозначают цифрами, которые вносят в подпись, сопровождая их текстом. 
Например: 

Рис. 1.24. Схема розміщення елементів касети: 
1 – розмотувач плівки; 
2 – сталеві ролики; 
3 – привідний валик; 
4 – опорні стояки. 

Слово «Рис.» и номер рисунка выделяем жирным. Название 
оставляем обычным текстом. 

Если рисунок не помещается на одной странице, можно перенести его 
на другие страницы, помещая название рисунка на первой странице, 
пояснительные данные – на каждой странице, и под ними обозначают: 
«Рис., страница ____». 

 
Таблицы 
Таблицу необходимо размещать непосредственно после текста, в 

котором она упоминается впервые, или на следующей странице. 
На все таблицы должны быть посылания в тексте. 
Слово «Таблица» указывают один раз справа над таблицей. Таблицы 

следует нумеровать арабскими цифрами. Номер таблицы состоит из 
номера раздела и порядкового номера таблицы, разделенных точкой. 
Например, «Таблица 5.4» (точка в конце не ставится). Это четвертая 
таблица пятого раздела. 

Таблица может иметь название, которое печатается строчными 
буквами (за исключением первой заглавной), выделяется жирным 
шрифтом и размещается над таблицей (на следующей строке после 
номера таблицы). После названия точка не ставится. 

Если строки или колонки таблицы выходят за границы формата 
страницы, таблицу делят на части, размещая одну часть под другой, 
или рядом, или перенося часть таблицы на следующую страницу, 
повторяя в каждой части таблицы ее шапку и боковик. 

При разделении таблицы на части допускается заменять ее шапку или 
боковик соответственно номерами столбцов или строк, нумеруя их 
арабскими цифрами в первой части таблицы. 

Над каждой следующей частью таблицы пишется «Продолжение 
таблицы» с указанием ее номера, если это не последняя часть таблицы, 
или «Окончание таблицы» с указанием номера, если это последняя 
часть таблицы. 
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Заголовки столбцов таблицы начинают с заглавной буквы, а 
подзаголовки – со строчной, если они составляют одно предложение с 
заголовком. Подзаголовки, имеющие самостоятельное значение, пишут 
с большой буквы. В конце заголовков и подзаголовков таблиц точки не 
ставят. Заголовки и подзаголовки столбцов указывают в единственном 
числе. 

Текст в таблице может быть немного меньше по размеру, нежели 
основной текст книги. В нашем случае, если текст книги 10 пт, то 
текст таблицы может быть 8 пт. 

Последняя страница 

Структура последней страницы представлена на рис. 4 
Надвыпускные данные книжного издания содержат: 
– полное имя автора или соавторов (фамилия, имя отчество). Фамилию 

автора выделяют полиграфическими средствами; 
– заглавие издания, которое приводят в форме, указанной на 

титульной странице или заменяющем ее элементе издания; 
– заглавие серии (для серийных изданий); 
– номер выпуска серии (для серийных изданий); 
– вид издания. 
Надвыпускные данные помещают перед выпускными данными 

издания. 
Выпускные данные книжного издания содержат: 
– информацию о редакторах, верстальщиках, печатниках и пр.; 
– дату подписания в печать; 
– формат бумаги и доля листа (см. Приложение 3); 
– информацию о гарнитуре основного текста и виде печати; 
– объем издания в условных печатных листах: 

объем издания в условных печатных листах = количество страниц 
книги * долю листа * коэффициент перевода в учетные единицы. 

Долю листа и коэффициент переводы в учетные единицы см. в 
Приложении 3. 

Так, если у нас книга формата А5 объемом в 300 страниц, то ее 
объем в условных печатных листах будет равен 300 * 1/16 * 0,93 ≈ 17,44. 

– объем издания в учетно-издательских листах: 

объем издания в учетно-издательских листах = количество символов в 
основном тексте книги / 40 000; 

– тираж (обозначают арабскими цифрами, после которых приводят 
слово «экз.» («экземпляров»)); 
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Рис. 4. Структура последней страницы: 

1 – надвыпускные данные: 1.1 – имя автора; 1.2 – название издания; 1.3 – вид издания; 2 
– выходные данные 

 
– номер заказа издательства; 
– юридическое имя издателя и его адрес. 
Выпускные данные приводят на концевой титульной странице или 

на заменяющем ее элементе издания. 
 
На этом теоретическая часть закончена. Приступаем к практике. 
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MS Word 2003 
 

Панели инструментов 

Для более удобной работы необходимо подключить и настроить 
некоторые панели инструментов. Итак, выполняем следующие команды: 

View → Toolbars → Standard (Вид → Панели инструментов → 
Стандартная). 

 

 
Рис. 1. Панель инструментов «Standart» (Стандартная): 

1 – создать новый документ; 
2 – открыть файл; 
3 – сохранить документ; 
4 – распечатать документ; 
5 – предварительный просмотр; 
6 – вырезать выделенный фрагмент; 
7 – копировать выделенный фрагмет; 
8 – вставить; 

9 – отменить последнее действие; 
10 – повторить отмененное действие; 
11 – разбить текст на колонки 
12 – включить/отключить панель «Drawing» 
(Рисование) 
13 – показать/скрыть непечатаемые знаки; 
14 – масштаб 

 
View → Toolbars → Formatting 

(Вид → Панели инструментов → Форматирование). 
 

 
Рис. 2. Панель инструментов «Formatting» (Форматирование): 

1 – стиль; 
2 – шрифт; 
3 – размер шрифта; 
4 – жирное начертание шрифта; 
5 – курсив; 
6 – подчеркнуть текст; 
7 – выровнять текст по левому краю; 
8 – выровнять текст по центру; 

9 – выровнять текст по правому краю; 
10 – выровнять текст по ширине страницы; 
11 – междустрочный интервал; 
12 – нумерованный список; 
13 – маркированный список; 
14 – границы; 
15 – выделение цветом; 
16 – цвет шрифта 

 
View → Toolbars → Word count 

(Вид → Панели инструментов → Статистика). 
 

 
Рис. 3. Панель инструментов «Word count» (Статистика) 
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View → Toolbars → Tables and borders 
(Вид → Панели инструментов → Таблицы и границы). 

 

 
Рис. 4. Панель инструментов «Tables and borders» 

(Таблицы и границы): 
1 – нарисовать таблицу; 
2 – стереть границу; 
3 – тип линии; 
4 – толщина линии; 
5 – цвет границы; 
6 – границы; 
7 – цвет заливки (фона); 
8 – вставить таблицу; 
9 – объединить ячейки; 

10 – разбить ячейки; 
11 – выравнивание текста в ячейке; 
12 – выровнять высоту строк; 
13 – выровнять ширину столбцов; 
14 – стиль автоформата таблицы; 
15 – направление текста; 
16 – сортировать данные по возрастанию; 
17 – сортировать данные по убыванию; 
18 – автосумма 

 
Разместите их так, как вам будет удобно. 
Но это еще не все. Давайте добавим несколько кнопок. Выполняем 

команду 
View → Toolbars → Customize 

(Вид → Панели инструментов → Настройка) 
и переходим на вкладку Commands (Команды). 

 

 
Рис. 5. Окно настройки панелей инструментов 
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Теперь для того, чтобы добавить кнопки, слева выбираем категорию, 
справа отыскиваем необходимую команду, нажимаем на нее и, не 
отпуская, перетягиваем на одну из панелей. 

Итак: 
Edit: Office clipboard, Find (Правка: Буфер обмена Office, 

Найти) и т.д. 
View: Print layout (Вид: Разметка страницы) и т.д. 
Insert: Page break, Page Numbers, Symbol, Equation editor (Вставка: 

Разрыв страницы, Номера страниц, Символ, Редактор формул) и т. д. 
Format: Superscript, Subscript, Font, Paragraph, Change case (Формат: 

Надстрочный знак, Подстрочный знак, Шрифт, Абзац, Регистр... 
(тот, который с тремя буквами А)) и т.д. 

 

 
Рис. 6. Дополнительные кнопки: 

1 – буфер обмена; 
2 – найти; 
3 – разметка страницы; 
4 – вставить разрыв; 
5 – вставить нумерацию страниц; 
6 – вставить символ; 

7 – вставить формулу; 
8 – верхний индекс; 
9 – нижний индекс; 
10 – шрифт; 
11 – абзац; 
12 – регистр 

 
Это значительно ускорит вашу работу. 

Создание макета 

Для начала создадим новый документ: 
File → New... (Файл → Новый). 

Далее переходим к настройкам страницы. Заходим в пункт меню 
File → Page setup (Файл → Параметры страницы). 

Переходим на вкладку Paper (Бумага). 
Устанавливаем paper size (размер бумаги) А5 (или другой). 
Возвращаемся на вкладку Margins (отступы) и устанавливаем поля 

сверху, снизу, справа и слева (не меньше) 2 см. Если книга имеет более 
200 страниц, тут же в поле Gutter (Переплет) можно указать 
дополнительный отступ к внутреннему полю. 

Выбираем значение portrait (книжная) в поле Orientation 
(Ориентация). Нажимаем OK. 

Сохраняем внесенные изменения. 
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Колонтитулы 

Разные колонтитулы на четных и нечетных страницах. Для 
того, чтобы задать разные колонтитулы на четных и нечетных страницах, 
необходимо выполнить команду 

File → Page setup (Файл → Параметры страницы). 
Переходим на вкладку Layout (Источник бумаги) и ставим галочку 

напротив Headers and Footers Different odd and even (Различать 
колонтитулы четных и нечетных страниц). 

Номера страниц. Для того, чтобы вставить номера страниц, 
достаточно выполнить команду 

Insert → Page Numbers (Вставка → Номера страниц). 
В появившемся окне указываем положение (top/вверху страницы или 

bottom/внизу страницы) и выравнивание (left/слева, center/от центра, 
right/справа, inside/внутри или outside/снаружи). 

Текст. В случае, если необходимо вставить в колонтитулы текст, 
выполните команду: 

View → Header and Footer (Вид → Колонтитулы). 
После этого вы автоматически перемещаетесь в верхний колонтитул, где 

можете смело вводить необходимый текст (данный текст будет отобра-
жаться на каждой странице). 

Для того, чтобы переместиться в нижний колонтитул, достаточно 
нажать на кнопку Switch between Header and Footer (Верхний/нижний 
колонтитул) на панели Колонтитулы. 

К каждому разделу свой колонтитул. Если стала задача каждому 
разделу задать свой колонтитул (например, название данного раздела), то 
необходимо после окончания каждого раздела вставить разрыв раздела: 

Insert → Break (Вставка → Разрыв) 
и в появившемся окне выбрать Section break types Next page (Новый 
раздел со следующей страницы). 

В режиме редактирования колонтитула разрываем связь с колонти-
тулами предыдущего раздела (панель Header and Footer/Колонтитулы, 
кнопка Link to Previous/Как в предыдущем разделе) отдельно для верхнего 
и нижнего колонтитулов, а также колонтитулов на правой, левой или 
первой странице). 

Теперь в новом разделе можно задавать другие колонтитулы. 

Оглавление 

Cтавим курсор в том месте, где должно быть содержание, и выполняем 
команду 

Insert → Reference → Index and Tables 
(Вставка → Ссылка → Оглавление и указатели). 
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Переходим на вкладку Table of Contents (Оглавление). 
Указываем значения, как показано на рис. 7: 
Show page numbers (Показать номера страниц) – да; 
Right align page numbers (Номера страниц по правому краю) – да; 
Tab leader (Заполнитель) – как правило, точки; 
Formats (Форматы) – на ваш вкус; 
Show levels (Уровни) – глубина иерархии ваших разделов. 
Нажимаем кнопку ОК. 
Теперь, чтоб занести какой-либо заголовок в содержание, выделяем его 

и на панели Outlining (Структура) в поле Outline Level (Уровень 
структуры) выбираем уровень: если это название раздела, выбираем 
Level 1 (Уровень 1), если подзаголовка раздела – Level 2 (Уровень 2) и т. д. 
Когда все разделы добавлены в оглавление, возвращаемся к полю 
оглавления и нажимаем на кнопку Update TOC (Обновить оглавление) 
на той же панели. В появившемся окне выбираем Update entire table 
(Обновить целиком) в случае, если надо вывести заново названия 
всех разделов, или Update page numbers only (Обновить номера 
страниц) в случае, если никакие изменения в названия разделов не 
вносились, а менялся лишь основной текст. Вот и все. 

 

 
Рис. 7. Окно «Index and Tables» (Оглавление и указатели) 

 
Конечно же, можно создать оглавление и вручную. 
Набрав текст оглавления, выделяем его и выравниваем по левому 

краю и выполняем команду 
Format → Tabs (Формат → Табуляция). 

Выставляем значения, как показано на рис. 8: 
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Tab stop position (Позиции табуляции) – приблизительно 10,8 см 
(ширина страницы без полей); 

Alignment (Выравнивание) – right (по правому краю); 
Leader (Заполнитель) – dots (точки). 
 

 
Рис. 8. Окно «Tabs» (Табуляция) 

Основной текст 

Выделяем текст и выполняем команду 
Format → Font (Формат → Шрифт). 

 

 
Рис. 9. Окно «Font» (Шрифт): вкладка Font (Шрифт) 
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Здесь мы можем выставить кегль, начертание, размер шрифта, 
задать надстрочные и подстрочные знаки (верхние и нижние индексы). 

Можно также воспользоваться панелью Formatting (Форматирование). 
Для того, чтобы уменьшить/увеличить межстрочный интервал 

(используется для устранения «висячих» символов и больших 
расстояний между словами), выделяем строку и выполняем команду 

Format → Font (Формат → Шрифт) 
и переходим на вкладку Character Spacing (Интервал). 
 

 
Рис. 10. Окно «Font» (Шрифт): вкладка Character Spacing (Интервал) 

 
В поле Spacing (Интервал) выбираем Expanded (Разреженный) или 

Condensed (Уплотненный)и устанавливаем значение 0,1-0,3 (не более). 
Чтоб перейти к настройкам абзаца, выполняем команду 

Format → Paragraph (Формат → Абзац). 
Здесь задаем параметры: 
Alignment (выравнивание) – по ширине страницы (justified). 
First line (Отступ красной строки) – 0,5-0,7 см. 
Spacing (Отступы) перед абзацем и после абзаца – 0 пт. 
Line Spacing (Междустрочный интервал) – Single (одинарный). 
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С помощью Line Spacing (Междустрочного интервала) можно 
также избавляться от висячих строк. Итак, чтоб «втянуть» одну строку, 
выделяем весь текст на странице и устанавливаем Line Spacing 
(Междустрочный интервал) приблизительно 0,98. Чтоб «вытолкнуть» 
одну строку, выделяем весь текст на странице и устанавливаем Line 
Spacing (Междустрочный интервал) приблизительно 1,02. 

 

 
Рис. 11. Окно «Paragraph» (Абзац) 

Списки 

Выделяем необходимый фрагмент текста и выполняем команду 
Format → Bullets and Numbering (Формат → Список). 

Далее выбираем Bulleted (Маркированный) или Numbered (Нуме-
рованный) и тип. Нажимаем кнопку OK. 

Отформатировать абзац списка можно по команде 
Format → Paragraph (Формат → Абзац). 

Отрегулировать расстояние между маркером и текстом элемента 
списка можно, выделив текст списка и выполнив команду 

Format → Tabs (Формат → Табуляция). 
Далее необходимо удалить существующие положения табуляции 

(чтоб старые не перекрывали новые), нажав на кнопку Clear all 
(Удалить все). Теперь можно задать свои параметры. 
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Рис. 12. Окно «Bullets and Numbering» (Списки) 

Сноски 

Для того, чтобы вставить сноску, ставим курсор в необходимом 
месте и выполняем команду 

Insert → Reference → Footnote (Вставка → Ссылка → Сноска). 
 

 
Рис. 13. Окно «Footnote» (Сноски) 
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Выставляем параметры: 
– Location (Положение) – Footnotes: Bottom of page (сноски: Внизу 

страницы) (если необходимо, чтобы текст сноски размещался на той же 
странице) или Endnotes: Bottom of document (концевые сноски: В конце 
документа) (если необходимо, чтобы все сноски размещались в конце 
книги); 

– Number format (Формат номера) – на вкус верстальщика; 
– Numbering (Нумерация) – Restart each page (На каждой странице) 

(если необходимо, чтоб на каждой странице нумерация начиналась с 
начала) или Continuous (Продолжить) (если нужна сквозная нумерация); 

– Apply changes to (Применить) – whole document (ко всему документу). 
Нажимаем кнопку Insert (Вставить). 

Специальные символы 

Выполняем команду 
Insert → Symbol (Вставка → Символ). 

Выбираем нужный символ в списке и нажимаем кнопку Insert 
(Вставить). 

 

 
Рис. 14. Окно «Symbol» (Символ) 

Формулы 

Выполняем команду 
Insert → Object (Вставка → Объект) 
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и выбираем в списке Microsoft Equation 3.0. Мы автоматически 
перемещаемся в Мастер формул (для того, чтобы отредактировать 
формулу, достаточно дважды нажать по ней левой кнопкой мыши). 

И первым делом задаем размеры: выполняем команду 
Size –> Define (Размер → Определить). 

С учетом шрифта основного текста (10 пт) выставляем значения: 
– Full (Обычный) – 10 пт; 
– Subscript/Superscript (Крупный индекс) – 5 пт; 
– Sub-Subscript/Superscript (Мелкий индекс) – 3 пт; 
– Symbol (Крупный символ) – 15 пт; 
– Sub-Symbol (Мелкий символ) – 10 пт. 
 

 
Рис. 15. Окно «Size» (Размеры) редактора формул 

 
Чтоб подправить шрифты, необходимо выполнить команду 

Style –> Define (Стиль → Определить). 
Все эти параметры задаются один раз. 

Рисунки 

Для вставки рисунка выполняем команду 
Insert → Picture → From file (Вставка → Рисунок → Из файла). 
Выбираем необходимое изображение и нажимаем кнопку Insert 

(Вставить). 
Отцентровуем рисунок: выделяем его и нажимаем на кнопку Center 

(По центру) на панели Formatting (Форматирование). 

Таблицы 

Для того, чтоб вставить таблицу, необходимо выполнить команду 
Table → Insert → Table (Таблица → Вставить → Таблица). 

Задаем количество столбцов и строк и нажимаем кнопку OK. 
Для того, чтобы вставить столбцы/строки, выделяем столбец/строку, 

относительно которых будет вставляться элемент, и выполняем 
команду Table → Insert → Columns to the left или Columns to the right / 
Rows above или Rows below (Таблица → Вставить → Столбцы слева или 
Столбцы справа / Строки выше или Строки ниже). 
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Рис. 16. Окно «Insert table» (Вставка таблицы) 

 
Для того, чтобы удалить столбцы/строки, выделяем их и выполняем 

команду Table → Delete → Columns / Rows (Таблица → Удалить → 
Столбцы / Строки). Аналогичным способом удаляется и таблица. 

Для того, чтобы объединить/разбить ячейки, выделяем их и выполняем 
команду 

Table → Merge cells / Split cells 
(Таблица → Объединить ячейки / Разбить ячейки). 

Для того, чтоб отформатировать линии таблицы, выполняем команду 
Format → Boders and Shading (Формат → Границы и заливка). 

 

 
Рис. 17. Окно «Boders and Shading» (Границы и заливка) 
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Очень полезной для форматирования таблицы является панель 
Tables and Borders (Таблицы и границы). 
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MS Word 2007 
 
Особенностью Word 2007, в отличие от предыдущих версий, является 

то, что файлы по умолчанию сохраняются в формате *.docx. 

Панели инструментов 

В Word 2007 все панели, которые можно подключить, и так 
активны. Рассмотрим каждую в отдельности. 

Панель быстрого доступа представлена на рис. 1. 
 

 
Рис. 1. Панель быстрого доступа: 

1 – создать новый документ; 
2 – открыть документ; 
3 – сохранить документ; 
4 – отменить последнее действие; 

5 – повторить последнее действие; 
6 – распечатать документ; 
7 – предварительный просмотр; 
8 – кнопка дополнительных параметров 

 

 
Рис. 2. Окно добавление команд в панель быстрого доступа 

 
Панель быстрого доступа – это единственна панель в Word 2007, где 

можно добавлять или удалять кнопки. Для добавления недостающих 
кнопок нажимаем на кнопку дополнительных параметров (крайняя 
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правая кнопка) и выбираем пункт More commands (Другие команды). 
Далее все просто. В поле Choose command from (Выбрать команды из) 
выбираем All commands (Все команды) (или какую-нибудь из основных 
панелей), в списке ниже находим нужную нам команду и нажимаем 
кнопку Add (Добавить). Выбрав все необходимые команды, нажимаем 
OK. Вот и все. 

 
Вкладка Home/Главная 

 

Панель Clipboard/Буфер обмена: 
Paste/Вставить 
Cut/Вырезать 
Copy/Копировать 
Format Painter/Формат по абзацу 
 

 

Панель Font/Шрифт: 
Font face/Гарнитура 
Font size/Размер шрифта 
Grow font/Увеличить размер 
Shrink font/Уменьшить размер 
Clear formatting/очистить формат 
Bold/Полужирный 
Italic/Курсив 
Underline/Подчеркнутый 
Strikethrough/Зачеркнутый 
Subscript/Подстрочный знак 
Superscript/Надстрочный знак 
Change case/Регистр 
Text highlight color/Цвет выделения текста 
Font color/Цвет текста 

 

Панель Paragraph 
Bullets/Маркер 
Numbering/Нумерация 
Multilevel list/Многоуровневый список 
Decrease indent/Уменьшить отступ 
Increase indent/Увеличить отступ 
Sort/Сортировка 
Show hide hidden formatting 
symbols/Отобразить скрытые символы 
форматирования 
Align text left/Выровнять текст по левому 
краю 
Center text/Выровнять по центру 
Align text right/Выровнять текст по правому 
краю 
Justify/Выровнять по ширине 
Line the paragraph spacing/Интервал 
Shading/Заливка 
Border/Границы 
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Панель Styles/Стили: 
Change styles/Изменить стили 

Панель Editing/Редактирование: 
Find/Найти 
Replace/Заменить 
Select/Выделить 

 
Вкладка Insert/Вставка 

 
 

Панель Pages/Страницы: 
Cover page/Титульная страница 
Blank page/Пустая страница 
Page break/Разрыв страницы 
 

 
 

Панель Tables/Таблицы: 
Table/Таблица 

 

Панель Illustrations/ 
Иллюстрации: 
Picture/Рисунок 
ClipArt/Клипарт 
Shapes/Фигуры 
SmartArt 
Chart/Диаграмма 
 

 
 

Панель Links/Ссылки: 
Hyperlink/Гиперссылка 
Bookmark/Закладка 
Cross-reference/Перекрестная ссылка 

 
 

Панель Header&Footer/ 
Колонтитулы: 
Header/Верхний колонтитул 
Footer/Нижний колонтитул 
Page Number/Номер страницы 
 

 

Панель Text/Текст: 
TextBox/Надпись 
QuickParts/Экспресс-блоки 
WordArt 
DropCap/Буквица 
Signature Line/Строка подписи 
Date&Time/Дата и время 
Object/Объект 
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Панель Symbols/Символы: 
Equition/Формула* 
Symbol/Символ 

*Примечание: Редактор формул активен только для формата *.docx 

 
Вкладка Page Layout/Разметка страницы 

 
 

Панель Themes/Темы 
Themes/Темы 
Colors/Цвета темы 
Fonts/Шрифты темы 
Effects/эффекты темы 

 

 

Панель Page Setup/Параметры 
страницы 
Margins/Поля 
Orientation/Ориентация 
Size/Размер 
Columns/Колонки 
Breaks/Разрывы 
Line Numbers/Номера строк 
Hyphenation/Расстановка переносов 

 

 
 

Панель Page Background/Фон 
страницы 
Watermark/Подложка 
Page Color/Цвет страницы 
Page Borders/Границы страниц 

 

 

Панель Paragraph/Абзац 
Indent Left/Отступ слева 
Indent Right/Отступ справа 
Spacing Before/Интервал до 
Spacing After/Интервал после 

 

 

Панель Arrange/Упорядочить 
Position/Положение 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Wrap Text/Обтекание текстом 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть
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Вкладка References/Ссылки 

 

Панель Table of Contents/ 
Оглавление 
Table of Contents/Оглавление 
Add Text/Добавить текст 
Update Table/Обновить таблицу 
 

 
 

Панель Footnotes/Сноски
Insert Footnote/Вставить сноску 
Insert Endnote/Вставить концевую сноску 
Next Footnote/Следующая сноска 
Show notes/Показать сноски 
 

 

Панель Citation&Bibliography/ 
Ссылки и списки литературы 
Insert Citation/Вставить ссылку 
Manage Sources/Управление источниками 
Style/Стиль 
Bibliography/Список литературы 
 

 
 

Панель Captions/Названия
Insert Caption/Вставить название 
Insert Table of Figures/Список иллюстраций 
Update Table/Обновить страницу 
Cross-reference/Перекрестная ссылка 

 
 

Панель Index/Предметный 
указатель 
Mark Entry/Пометить элемент 
Insert Index/Предметный указатель 
Update Index/Обновить указатель 
 

 

Панель Table of Authorities/ 
Таблица ссылок 
Mark Citation/Пометить ссылку 
Insert table of Authorities/Таблица ссылок 
Update Table/Обновить таблицу

 
Вкладка Mailings/Рассылки 

 

Панель Create/Создание
Envelopes/Конверты 
Labels/Наклейки 

 

Панель Start Mail Merge/Начало
слияния 
Start Mail Merge/Начать слияние 
Select Recipients/Выбрать получателей 
Edit Recipient List/Изменить список 
получателей 
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Панель Write&Insert Fields/ 
Составление документа и 
вставка полей 
Highlight Merge Fields/Выделить поля 
слияния 
Address Block/Блок адреса 
Greeting Line/Строка приветствия 
Insert Merge Field/Вставить поле слияния 
Rules/Правила 
Match Fields/Подбор полей 
Update Labels/Обновить наклейки 

 

 

Панель Preview Results/ 
Просмотр результатов 
Preview Results/Просмотреть результаты 
Go to Record/Запись 
Find Recipient/Найти получателя 
Auto Check for Errors/Автопоиск ошибок 

 
Панель Finish/Завершение 
Finish&Merge/Найти и объединить 

 
Вкладка Review/Рецензирование 

 

Панель Proofing/Правописание 
Spelling&Grammar/Правописание 
Research/Справочные материалы 
Thesaurus/Тезаурус 
Translate/Перевод 
Translation ScreenTip//Всплывающая 
подсказака с переводом 
Set language/Выбрать язык 
Word Count/Статистика 

 

 
 

Панель Comments/Примечания 
New Comment/Создать примечание 
Delete/Удалить 
Previous/Предыдущее 
Next/Следующее 
 

 

Панель Tracking/Запись 
исправлений 
Track Changes/Исправления 
Ballons/Выноски 
Display for Review/Отобразить для проверки 
Show Markup/Показать исправления 
Reviewing Pane/Область проверки 
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Панель Changes/Изменения
Accept/Принять 
Reject/Отклонить 
Previous/Назад 
Next/Далее 

 
 

Панель Compare/Сравнение
Compare/Сравнить 
Show Source Document/Показать исходные 
документы 

Панель Protect/Защита
Protect document/Защитить документ 

 
Вкладка View/Вид 

 

Панель Document Views/Режимы 

просмотра документа 
Print Layout/Разметка страницы 
Full Screen Reading/Режим чтения 
Web Layout/Веб–документ 
Outline/Структура 
Draft/Черновик 

 
 

Панель Show/Hide/Показать или 
скрыть 
Ruler/Линейка 
Gridlines/Сетка 
Message bar/Панель сообщений 
Document map/Схема документа 
Thumbnails/Эскизы 

 

 

Панель Zoom/Масштаб 
Zoom/Масштаб 
One Page/Одна страница 
Two Pages/Две страницы 
Page Width/По ширине страницы 

 

 

Панель Window/Окно 
New Window/Новое окно 
Arrange All/Упорядочить все 
Split/Разделить 
View Side by Side/Рядом 
Synchronous Scrolling/Синхронная прокрутка 
Reset Window Position/Восстановить 
расположение окна 
Switch Windows/Перейти в другое окно 
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Панель Macros/Макросы 
Macros/макросы 

Создание макета 

Для создания нового документа нажимаем на кнопку New... (Новый) на 
панеле быстрого доступа. 

 

 
Рис. 3. Кнопка New (Новый) 

 
Далее переходим к настройкам страницы. Заходим на вкладку Page 

loyout (Разметка страницы), на панели Page setup (Настройки страницы) 
нажимаем на кнопку дополнительных параметров и в появившемся 
окне переходим на вкладку Paper (Размер бумаги). Далее есть два варианта 
срздания макета. 

Вариант 1. В поле Paper Size (Размер бумаги) выбираем формат А5. 
Если данного размера нет, то выбираем пункт Custom Size (Другой) и 
задаем размер бумаги: Width (Ширина) – 14,8 см и Height (Высота) – 
21 см (рис. 4). 
 

 
Рис. 4. Установка размера страницы 
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В этом же окне переходим на вкладку Margins (Поля). Устанавливаем 
отступ сверху, снизу, справа и слева (не меньше) 2 см (рис. 5). В поле 
Orientation (Ориентация) выбираем portrait (книжная). Нажимаем на 
кнопку ОК. 

 

 
Рис. 5. Установка полей и ориентации страницы 

 
И уже после окончания верстки книги создаем буклет с помощью 

Adobe Acrobat Pro. 
Вариант 2. В поле Paper Size (Размер бумаги) выбираем формат А4 

(рис. 6). 
 

 
Рис. 6. Установка размера страницы 

 
В этом же окне переходим на вкладку Margins (Поля). Устанавливаем 

отступ сверху, снизу, справа и слева (не меньше) 2 см (рис. 5). В поле 
Orientation (Ориентация) выбираем landscape (альбомная). В поле Multiple 
Pages (Страницы несколько страниц) выбираем Book fold (брошюра), 
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Sheets per booklet – all (число страниц в брошюре – все) (рис 7). Нажимаем 
на кнопку ОК. 

 

 
Рис. 7. Создание брошюры 

Колонтитулы 

Вкладка Header & Footer Tools – Design (Работа с колонти-
тулами – Конструктор) появляется при работе с колонтитулами. 

 

Панель Header & Footer 
(Колонтитулы) 
Header (Верхний колонтитул) 
Footer (Нижний колонтитул) 
Page Number (Номер страницы) 

 

Панель Insert (Вставить)
Date & Time (Дата и время) 
Quick Parts (Экспресс-блоки) 
Picture (Рисунок) 
Clip art (Клип) 

 

Панель Navigation (Переходы)
Go to Header (Перейти к верхнему 
колонтитулу) 
Go to Footer (Перейти к нижнему колонтитулу)
Previous (Предыдущий раздел) 
Next (Следующий раздел) 
Link to Previous (Как в предыдущем разделе) 
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Панель Options (Параметры) 
Different first page (Особый колонтитул для 
первой страницы) 
Different Odd & Even pages (Разные 
колонтитулы для четных и нечетных страниц) 
Show document text (Показать текст документа)
 

 

Панель Position (Положение) 
Header from top (Положение верхнего 
колонтитула относительно верхнего края) 
Footer from Bottom (Положение нижнего 
колонтитула относительно нижнего края) 
Insert Alignment Tab (Вставить табуляцию 
с выравниванием) 
 
Панель Close (Закрыть) 
Close Header & Footer (Закрыть окно 
колонтитулов) 
 

 
Разные колонтитулы на четных и нечетных страницах. Для того, 

чтобы задать разные колонтитулы на четных и нечетных страницах, 
необходимо перейти на вкладку Page Layout (Разметка страницы) и в 
поле Page Setup (Параметры страницы) в нижнем правом углу нажимаем 
на кнопку дополнительных параметров. После этого в появившемся окне 
переходим на вкладку Layout (Макет) и ставим галочку напротив Headers 
and Footers Different odd and even (Различать колонтитулы четных и 
нечетных страниц) (рис. 6). 

 

 
Рис. 6. Окно Layout (Макет) 
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Или же в режиме редактирования колонтитулов перейти на вкладку 
Header & Footer Tools – Design (Работа с колонтитулами – 
Конструктор) и на панели Options (Параметры) отметить пункт Different 
odd and even (Различать колонтитулы четных и нечетных страниц). 

Номера страниц. Для того, чтоб вставить номера страниц, переходим 
на вкладку Insert (Вставка). На панели Header & Footer (Колонтитулы) 
нажимаем на кнопку Page Number (Номер страницы) и выбираем пункт 
Format Page Numbers (Формат номера страницы). В выпавшем списке 
указываем положение (сверху или снизу страницы) и выравнивание 
(слева, от центра, справа, внутри или снаружи). 

 

 
Рис. 7. Вставка номера страницы 

 
Или же в режиме редактирования колонтитулов перейти на вкладку 

Header & Footer Tools – Design (Работа с колонтитулами – Конст-
руктор) и выбрать на панели Header & footer (Колонтитулы) пункт 
Page Number (Номер страницы). Далее, как и в предыдущем случае, 
указываем положение. 

Текст. В случае, если необходимо вставить в колонтитулы текст, 
на вкладке Insert (Вставка) в поле Header & Footer (Колонтитулы) 
нажимаем на кнопку Header (Верхний колонтитул) и выбираем пункт 
Edit header (Изменить верхний колонтитул) 

После этого вы автоматически перемещаетесь в верхний колонтитул, где 
можете смело вводить необходимый текст (данный текст будет отобра-
жаться на каждой странице). 

Аналогично с нижним колонтитулом. 
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Рис. 8. Изменение колонтитула 

 
К каждому разделу свой колонтитул. Если стала задача каждому 

разделу задать свой колонтитул (например, название данного раздела), 
то необходимо после окончания каждого раздела вставить разрыв 
раздела. 

Переходим на вкладку Page Layout (Разметка страницы) и в поле 
Page setup (Параметры страницы) нажимаем на кнопку Breaks (Разрывы). 
В появившемся списке выбираем Section break Next page (Разрывы 
разделов Следующая страница). 

В режиме редактирования колонтитула разрываем связь с колонти-
тулами предыдущего раздела (панель Navigation/Переходы, кнопка Link 
to Previous/Как в предыдущем разделе). При том проделывать данную 
процедуру только с теми колонтитулами, которые собираемся менять 
(верхний, нижний, колонтитулы на правой, левой или первой странице). 

Теперь в новом разделе можно задавать другие колонтитулы. 
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Рис. 9. Вставка разрыва раздела 

Оглавление 

Добавляем кнопку Tabs (Табуляция) на панель быстрого доступа. 
Для этого нажимаем на кнопку Customize Quick Access Toolbar (Настройка 
панели быстрого доступа) и выбираем из выпавшего списка More 
commands (Другие команды). В поле Choose command from (Выбрать 
команды из) выбираем All commands (Все команды). Находим в списке 
Tabs (Табуляция) и нажимаем на кнопку Add (Добавить). Затем нажимаем 
на кнопку OK. 

Cтавим курсор в том месте, где должно быть оглавление, 
переходим на вкладку References (Ссылки), на панели Table of Contents 
(Оглавление) нажимаем на дополнительные параметры кнопки Table of 
Contents (Оглавление) и выбираем в выпавшем меню пункт Insert Table 
of Contents (Оглавление). 

Указываем: 
Show page numbers (Показать номера страниц) – да; 
Right align page numbers (Номера страниц по правому краю) – да; 
Tab leader (Заполнитель) – как правило, точки; 
Formats (Форматы) – на ваш вкус; 
Show levels (Уровни) – глубина иерархии ваших разделов. 
Нажимаем кнопку ОК. 
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Рис. 12. Окно Table of Contents (Оглавление) 

 
Теперь чтоб занести какое-либо заголовок в содержание, выделяем его 

и на вкладке References (Ссылки) нажимаем на кнопку Add Text (Добавить 
текст) панели Table of Contents (Оглавление) и выбираем уровень: если 
это название раздела, выбираем Уровень 1, если подзаголовка раздела – 
Уровень 2 и т.д. (рис. 13). Когда все разделы добавлены в оглавление, 
возвращаемся к полю оглавления и нажимаем на кнопку Update table 
(Обновить таблицу) на той же панели. В появившемся окне выбираем 
Update entire table (Обновить целиком) в случае, если надо вывести заново 
названия всех разделов, или Update page numbers only (Обновить номера 
страниц) в случае, если никакие изменения в названия разделов не 
вносились, а менялся лишь текст. Вот и все. 

 

 
Рис. 13. Добавление заголовков в оглавление 

 
Можно также сделать оглавление вручную. 
Выделяем набранный текст оглавления, выравниваем его по левому 

краю и нажимаем на кнопку Tabs (Табуляция) (предварительно добавьте 
данную кнопку на одну из панелей). 
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Выставляем значения: 
Tab stop position (Позиции табуляции) – приблизительно 10,8 см 

(ширина страницы без полей); 
Alignment (Выравнивание) – right (по правому краю); 
Leader (Заполнитель) – dots (точки). 
Теперь достаточно после заголовка вставить табуляцию (Tab), и линия 

из точек готова. 
Далее текст оглавления форматируется на усмотрение верстальщика. 
 

 
Рис. 10. Окно параметров табуляции 

Основной текст 

Выделяем весь текст и переходим на вкладку Home (Главная). Здесь 
нам понадобятся две панели: Font (Шрифт) и Paragraph (Абзац). 

 

 
Рис. 15. Панели Font (Шрифт) и Paragraph (Абзац) 

 
На них находятся все необходимые инструменты для работы с 

текстом: гарнитура, размер шрифта, начертание, выравнивание... Здесь 
же можно задать межбуквенное расстояние. Выделяем строку, нажимаем 
на кнопку дополнительных параметров в правом нижнем углу панели 
Font (Шрифт) и переходим на вкладку Advanced (Дополнительно). 
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Рис. 16. Установка межбуквенного расстояния 

 
Для того, чтоб немного разредить межбуквенное расстояние, в поле 

Spacing (Интервал) выбираем Expanded (Разреженный) и устанавливаем 
значение 0,1-0,3 (не более). Для того, чтоб уплотнить межбуквенное 
расстояние, в поле Spacing (Интервал) выбираем Condensed (Уплотненный) 
и устанавливаем значение 0,1-0,3 (не более). 

Чтоб перейти к настройкам абзаца, переходим на вкладку Home 
(Главная) и нажимаем на кнопку дополнительных параметров в правом 
нижнем углу панели Paragraph (Абзац) (рис. 17). 

Задаем следующие параметры: 
Text alignment (выравнивание текста) – по ширине страницы (justified). 
First line (Отступ красной строки) – 0,5-0,7 см. 
Spacing (Отступы) перед абзацем и после абзаца – 0 пт. 
Line Spacing (Междустрочный интервал) – Single (одинарный). 
С помощью Line Spacing (Междустрочного интервала) можно также 

избавляться от висячих строк. Чтоб «втянуть» одну строку, выделяем 
весь текст на странице и устанавливаем Line Spacing (Междустрочный 
интервал) приблизительно 0,98. Чтоб вытолкнуть одну строку, выделяем 
весь текст на странице и устанавливаем Line Spacing (Междустрочный 
интервал) приблизительно 1,02. 
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Рис. 17. Настройка параметров абзаца 

Списки 

Выделяем необходимый фрагмент текста и на панели Paragraph 
(Абзац) вкладки Home (Главная) выбираем Bulleted (Маркированный) или 
Numbered (Нумерованный). 

 

 
Рис. 18. Создание маркированного списка 
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Если нужный вам стиль отсутствует, в выпавшем списке выберите 
пункт Define New Bullet (Define New Bullet) (для маркированных списков) 
или Define New number Format (Define New number Format) (для нумеро-
ваных списков). 

Отформатировать абзац списка можно так же, как и обычный текст, 
нажав на кнопку дополнительных настроек в правом нижнем углу панели 
Paragraph (Абзац) на вкладке Home (Главная). 

Отрегулировать расстояние между маркером и текстом элемента 
списка можно, выделив текст списка и нажав на кнопку Tabs (Табуляция). 
Далее необходимо удалить существующие положения табуляции (чтоб 
старые не перекрывали новые), нажав на кнопку Clear all (Удалить все). 
Теперь можно задать свои параметры. 

Сноски 

Для того, чтобы вставить сноску, ставим курсор в необходимом месте, 
переходим на вкладку References (Ссылки) и нажимаем на кнопку 
дополнительных параметров в правом нижнем углу панели Footnotes 
(Сноски). 

 

 
Рис. 19. Создание сноски 

 
Выставляем параметры: 
– Location (Положение) – Footnotes: Bottom of page (сноски: Внизу 

страницы) (если необходимо, чтобы текст сноски размещался на той же 
странице) или Endnotes: Bottom of document (концевые сноски: В конце 
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документа) (если необходимо, чтобы все сноски размещались в конце 
книги); 

– Number format (Формат номера) – на усмотрение верстальщика; 
– Numbering (Нумерация) – Restart each page (На каждой странице) 

(если необходимо, чтоб на каждой странице нумерация начиналась с 
начала) или Continuous (Продолжить) (если нужна сквозная нумерация); 

– Apply changes to (Применить) – whole document (ко всему документу). 
Нажимаем кнопку Insert (Вставить). 

Специальные символы 

Переходим на вкладку Insert и на панели Символы нажимаем 
кнопку Symbol (Символ). Выбираем нужный. 

 

 
Рис. 19. Вставка специального символа 

 
Далее можно выбрать пункт More symbols (Другие символы). Выбираем 

нужный символ в списке и нажимаем кнопку Insert (Вставить). 
 

 
Рис. 20. Окно вставки специальных символов 
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Формулы 

Переходим на вкладку Insert (Вставка), в поле Symbols (Символы) 
нажимаем на дополнительные параметры Equation (Формула) и в выпавшем 
списке выбираем Insert new Equation (Вставить новую формулу) (доступно 
только для формата *.docx). После этого у нас появляется поле для ввода 
формулы и дополнительная вкладка Design (Конструктор), на которой 
размещены все необходимые математические знаки. 

 
Вкладка Equation Tools – Design/Работа с формулами – Конструктор 

 

Панель Tools/Сервис 
Equition/Формула 
Professional/Профессиональный 
Linear/Линейный 
Normal Text/Обычный текст 

 
Панель Symbols/Символы 
Up/Вверх 
Down/Вниз 
More/Дополнительные параметры 
 

 
Панель Structures/Структуры 
Fraction/Дробь 
Script/Индекс 
Radical/Радикал 
Integral/Интеграл 
Large operator/Крупный оператор 
Bracket/Скобка 
Function/Функция 
Accent/Диакритические знаки 
Limit and Log/Предел и логарифм 
Operator/Оператор 
Matrix/Матрица 

 
Далее работаем с формулой как с обычным текстом. 
Для выхода из Мастера формул достаточно нажать левой кнопкой 

мыши по пустому полю. 

Рисунки 

Для вставки рисунка переходим на вкладку Insert (Вставка), на 
панели Illustrations(Иллюстрации) нажимаем кнопку Picture (Рисунок). 
Выбираем необходимое изображение и нажимаем кнопку Insert 
(Вставить). 

Отцентровуем рисунок: выделяем его и на вкладке Home нажимаем 
на кнопку Center (По центру) панели Paragraph (Абзац). 
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Вкладка Picture Tool – Format/Работа с рисунками – Формат 
Данная вкладка появляется при работе с изображениями. 
Для формата *.doc вкладка имеет следующие панели: 

 

Панель Adjust/Измерение 
Brightness/Яркость 
Contrast/Контраст 
Recolor/Перекрасить 
Compress Pictures/Сжать рисунки 
Reset Picture/Сброс параметров рисунка 

 
 

Панель Shadow Effects/Эффекты 
тени 
Shadow Effects/Эффекты тени 
Nudge Shadow/Сдвинуть тень 
Shadow On/Off/Вкл/выкл тень 

 

Панель Border/Граница 
Picture Border/Граница рисунка 
Dashes/Штрихи 
Weight/Толщина 

 

Панель Arrange/Упорядочить 
Position/Положение 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Wrap Text/Обтекание текстом 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 
 
Панель Size/Размер 
Crop/Обрезка 
Height/Высота 
Width/Ширина 

 
Для формата *.docx вкладка состоит из следующих панелей: 

 

Панель Adjust/Измерение 
Brightness/Яркость 
Contrast/Контраст 
Recolor/Перекрасить 
Compress Pictures/Сжать рисунки 
Change picture/Изменить рисунок 
Reset Picture/Сброс параметров рисунка 

 

Панель Picture styles/Стили 
рисунков 
Picture shape/Форма рисунка 
Picture border/Граница рисунка 
Picture effects/Эффекты для рисунка 
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Панель Arrange/Упорядочить 
Position/Положение 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Wrap Text/Обтекание текстом 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 
 

Панель Size/Размер 
Crop/Обрезка 
Height/Высота 
Width/Ширина 

 
Вкладка Drawing Tool – Format/Средства рисования – формат 
Данная вкладка появляется при работе с автофигурами. 

 
 

Панель Insert Shapes/Вставка 
фигур 
Edit shape/Изменить фигуру 
Edit text/Изменить текст 

 

Панель Shape Styles/Стили фигур 
Shape Fill/Заливка фигуры 
Shape Outline/Контур фигуры 
Change Shape/Изменить фигуру 

 

 

Панель Shadow Effects/Эффекты 
тени 
Shadow Effects/Эффекты тени 
Nudge Shadow/Сдвинуть тень 
Shadow On/Off/Вкл/выкл тень 

 

 
 

Панель 3-D Effects/Объем 
3-D Effects/Объем 
Tilt/Повернуть 
3-D On/Off/Вкл/выкл объем 

 

Панель Arrange/Упорядочить 
Position/Положение 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Wrap Text/Обтекание текстом 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 
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Панель Size/Размер 
Height/Высота 
Width/Ширина 

 
Вкладка Text Box Tools – Format/Работа с надписями – Формат 
Данная вкладка появляется при работе с надписями. 

 
 

Панель Text/Текст 
Draw Text Box/Нарисовать надпись 
Text Direction/Направление текста 
Create Link/Создать связь 
Break link/Разорвать всязь 

 

 

Панель Text Box Styles/Стили 
надписей 
Shape Fill/Заливка фигуры 
Shape Outline/Контур фигуры 
Change Shape/Изменить фигуру 

 

 

Панель Shadow Effects/Эффекты 
тени 
Shadow Effects/Эффекты тени 
Nudge Shadow/Сдвинуть тень 
Shadow On/Off/Вкл/выкл тень 

 

 
 

Панель 3-D Effects/Объем 
3-D Effects/Объем 
Tilt/Повернуть 
3-D On/Off/Вкл/выкл объем 

 

Панель Arrange/Упорядочить 
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 

 
Панель Size/Размер 
Height/Высота 
Width/Ширина 

 



56 

Таблицы 

Для вставки таблицы необходимо на панели Tables (Таблицы) нажать 
на дополнительные параметры кнопки Table (Таблица) и выделить 
необходимое количесто столбцов и строк. 

 

 
Рис. 21. Вставка таблицы 

 
Или же выбираем пункт Insert table (Вставить таблицу).Задаем 

количество столбцов и строк и нажимаем кнопку OK. 
При работе с таблицами используется вкладка Table (Таблица), 

которая имеет следующие панели. 
 
Вкладка Table Tool – Design/Работа с таблицами – Конструктор 
Появляется при работе с таблицами. 

 

Панель Table Style Options/ 
Параметры стилей таблиц 
Header Row/Строка заголовка 
Total Row/Строка итогов 
Banded Rows/Чередующиеся строки 
First column/Первый столбец 
Last column/Последний столбец 
Banded Columns/Чередующиеся столбцы 
 

 
Панель Table Styles/Стили таблиц 
Styles/Стили 
Shading/Заливка 
Borders/Границы
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Панель Draw Borders/Рисование 
границ 
Line Style/Стиль пера 
Line weight/Толщина пера 
Pen color/Цвет пера 
Draw Table/Нарисовать таблицу 
Eraser/Ластик

 
Вкладка Table Tool – Layout/Работа с таблицами – Макет 
Появляется при работе с таблицами. 

 
 

Панель Table/Таблица 
Select/Выделить 
View Gridlines/Отобразить сетку 
Properties/Свойства 

 

Панель Rows&Columns/Строки и 
столбцы 
Delete/Удалить 
Insert above/Вставить сверху 
Insert Below/Вставить снизу 
Insert Left/Вставить слева 
Insert Right/Вставить справа 
 

 
 

Панель Merge/Объединение 
Merge cells/Объединить ячейки 
Split cells/Разделить ячейки 
Split table/Разделить таблицу 

 

Панель Cell Size/Размер ячейки 
AutoFit/Автоподбор 
Height/Высота строки таблицы 
Width/Ширина столбца таблицы 
Distribute rows/Выровнять высоту строк 
Distribute columns/Выровнять ширину 
столбцов 
 

 
 

Панель Alignment/Выравнивание 
Align/Выровнять 
Text direction/Направление текста 
Cell margins/Поля ячейки 

 

Панель Data/Данные 
Sort/Сортировка 
Repeat header rows/Повторить строки 
заголовков 
Convert to text/Преобразовать в текст 
Formula/Формула
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MS Word 2010 
 
В Word 2010, как и в Word 2007, файлы по умолчанию сохраняются в 

формате *.docx. 

Панели инструментов 

Панель быстрого доступа представлена на рис. 1. 
 

 
Рис. 1. Панель быстрого доступа: 

1 – создать новый документ; 
2 – открыть документ; 
3 – сохранить документ; 
4 – отменить последнее действие; 

5 – повторить последнее действие; 
6 – распечатать документ; 
7 – предварительный просмотр; 
8 – кнопка дополнительных параметров 
 

Для добавления недостающих кнопок нажимаем на кнопку допол-
нительных параметров (крайняя правая кнопка) и выбираем пункт 
More commands (Другие команды). Далее все просто. В поле Choose 
command from (Выбрать команды из) выбираем All commands (Все 
команды) (или какую-нибудь из основных панелей), в списке ниже 
находим нужную нам команду и нажимаем кнопку Add (Добавить). 
Выбрав все необходимые команды, нажимаем OK. 

 

 
Рис. 2. Окно добавление команд в панель быстрого доступа 
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Вкладка File/Файл 

 
Рис. 3. Вкладка File/Файл: 

1 – Save/Сохранить 
2 – Save as/Сохранить как 
3 – Open/Открыть 
4 – Close/Закрыть 
5 – Info/Сведения 
6 – Recent/Последние 
7 – New/Создать 

8 – Print/Печать 
9 – Save&Send/Сохранить и отправить 
10 – Help/Справка 
11 – Add-Ins 
12 – Options/Параметры 
13 – Exit/Выход 

 
Вкладка Home/Главная 

 

Панель Clipboard/Буфер обмена: 
Paste/Вставить 
Cut/Вырезать 
Copy/Копировать 
Format Painter/Формат по абзацу 
 

 

Панель Font/Шрифт: 
Font face/Гарнитура 
Font size/Размер шрифта 
Grow font/Увеличить размер 
Shrink font/Уменьшить размер 
Change case/Регистр 
Clear formatting/очистить формат 
Bold/Полужирный 
Italic/Курсив 
Underline/Подчеркнутый 
Strikethrough/Зачеркнутый 
Subscript/Подстрочный знак 
Superscript/Надстрочный знак
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Text effects/Параметры анимации 
Text highlight color/Цвет выделения текста 
Font color/Цвет текста 
 

 

Панель Paragraph 
Bullets/Маркер 
Numbering/Нумерация 
Multilevel list/Многоуровневый список 
Decrease indent/Уменьшить отступ 
Increase indent/Увеличить отступ 
Sort/Сортировка 
Show hide hidden formatting 
symbols/Отобразить скрытые символы 
форматирования 
Align text left/Выровнять текст по левому краю 
Center text/Выровнять по центру 
Align text right/Выровнять текст по правому 
краю 
Justify/Выровнять по ширине 
Line the paragraph spacing/Интервал 
Shading/Заливка 
Border/Границы 

 

Панель Styles/Стили: 
Change styles/Изменить стили 

Панель Editing/Редактирование: 
Find/Найти 
Replace/Заменить 
Select/Выделить 

 
Вкладка Insert/Вставка 

 

Панель Pages/Страницы: 
Cover page/Титульная страница 
Blank page/Пустая страница 
Page break/Разрыв страницы 

 
 

Панель Tables/Таблицы: 
Table/Таблица 

 

Панель Illustrations/Иллюстрации: 
Picture/Рисунок 
ClipArt/Картинка 
Shapes/Фигуры 
SmartArt 
Chart/Диаграмма 
Screenshot/Снимок 
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Панель Links/Ссылки: 
Hyperlink/Гиперссылка 
Bookmark/Закладка 
Cross-reference/перекрестная ссылка 

 
 

Панель Header&Footer/ 
Колонтитулы: 
Header/Верхний колонтитул 
Footer/Нижний колонтитул 
Page Number/Номер страницы 
 

 

Панель Text/Текст: 
TextBox/Надпись 
QuickParts/Экспресс-блоки 
WordArt 
DropCap/Буквица 
Signature Line/Строка подписи 
Date&Time/Дата и время 
Object/Объект 
 
Панель Symbols/Символы: 
Equition/Формула* 
Symbol/Символ 

*Примечание: Редактор формул активен только для формата *.docx 

 
Вкладка Page Layout/Разметка страницы 

 
 

Панель Themes/Темы 
Themes/Темы 
Colors/Цвета темы 
Fonts/Шрифты темы 
Effects/эффекты темы 
 

 

Панель Page Setup/Параметры 
страницы 
Margins/Поля 
Orientation/Ориентация 
Size/Размер 
Columns/Колонки 
Breaks/Разрывы 
Line Numbers/Номера строк 
Hyphenation/Расстановка переносов 
 

 
 

Панель Page Background/Фон 
страницы 
Watermark/Подложка 
Page Color/Цвет страницы 
Page Borders/Границы страниц 
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Панель Paragraph/Абзац 
Indent Left/Отступ слева 
Indent Right/Отступ справа 
Spacing Before/Интервал до 
Spacing After/Интервал после 

 

 

Панель Arrange/Упорядочить 
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть

 
Вкладка References/Ссылки 

 

Панель Table of Contents/ 
Оглавление 
Table of Contents/Оглавление 
Add Text/Добавить текст 
Update Table/Обновить таблицу 
 

 
 

Панель Footnotes/Сноски 
Insert Footnote/Вставить сноску 
Insert Endnote/Вставить концевую сноску 
Next Footnote/Следующая сноска 
Show notes/Показать сноски 

 

 

Панель Citation&Bibliography/ 
Ссылки и списки литературы 
Insert Citation/Вставить ссылку 
Manage Sources/Управление источниками 
Style/Стиль 
Bibliography/Список литературы 

 

 
 

Панель Captions/Названия 
Insert Caption/Вставить название 
Insert Table of Figures/Список иллюстраций 
Update Table/Обновить страницу 
Cross-reference/Перекрестная ссылка 

 

 
 

Панель Index/Предметный 
указатель 
Mark Entry/Пометить элемент 
Insert Index/Предметный указатель 
Update Index/Обновить указатель 
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Панель Table of Authorities/ 
Таблица ссылок 
Mark Citation/Пометить ссылку 
Insert table of Authorities/Таблица ссылок 
Update Table/Обновить таблицу

 
Вкладка Mailings/Рассылки 

 
 

Панель Create/Создание
Envelopes/Конверты 
Labels/Наклейки 

 

Панель Start Mail Merge/Начало
слияния 
Start Mail Merge/Начать слияние 
Select Recipients/Выбрать получателей 
Edit Recipient List/Изменить список 
получателей 
 

 

Панель Write&Insert Fields/ 
Составление документа и вставка 
полей 
Highlight Merge Fields/Выделить поля 
слияния 
Address Block/Блок адреса 
Greeting Line/Строка приветствия 
Insert Merge Field/Вставить поле слияния 
Rules/Правила 
Match Fields/Подбор полей 
Update Labels/Обновить наклейки 
 

 

Панель Preview Results/ 
Просмотр результатов 
Preview Results/Просмотреть результаты 
Go to Record/Запись 
Find Recipient/Найти получателя 
Auto Check for Errors/Автопоиск ошибок 
 
Панель Finish/Завершение
Finish&Merge/Найти и объединить 

 
Вкладка Review/Рецензирование 

 

Панель Proofing/Правописание
Spelling&Grammar/Правописание 
Research/Справочники 
Thesaurus/Тезаурус 
Word Count/Статистика 
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Панель Language/Язык 
Translate/Перевод 
Language/Язык 

 
 

Панель Comments/Примечания 
New Comment/Создать примечание 
Delete/Удалить 
Previous/Предыдущее 
Next/Следующее 
 

 

Панель Tracking/Запись 
исправлений 
Track Changes/Исправления 
Display for Review/Отобразить для 
проверки 
Show Markup/Показать исправления 
Reviewing Pane/Область проверки 

 

 
 

Панель Changes/Изменения 
Accept/Принять 
Reject/Отклонить 
Previous/Назад 
Next/Далее 

 

 
 

Панель Compare/Сравнение 
Compare/Сравнить 

Панель Protect/Защита 
Block Authors/Блокировать авторов 
Restrict Editing/Ограничить редактирование

 
Вкладка View/Вид 

 

Панель Document Views/Режимы 

просмотра документа 
Print Layout/Разметка страницы 
Full Screen Reading/Режим чтения 
Web Layout/Веб–документ 
Outline/Структура 
Draft/Черновик

Панель Show/Показать 
Ruler/Линейка 
Gridlines/Сетка 
Navigation Pane/Область навигации 
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Панель Zoom/Масштаб 
Zoom/Масштаб 
One Page/Одна страница 
Two Pages/Две страницы 
Page Width/По ширине страницы 
 

 

Панель Window/Окно 
New Window/Новое окно 
Arrange All/Упорядочить все 
Split/Разделить 
View Side by Side/Рядом 
Synchronous Scrolling/Синхронная 
прокрутка 
Reset Window Position/Восстановить 
расположение окна 
Switch Windows/Перейти в другое окно 

 
Панель Macros/Макросы 
Macros/макросы 

 
В Word 2010, в отличие от Word 2007, можно добавлять свои 

собственные вкладки и панели. Для этого достаточно перейти на вкладку 
File/Файл, нажать на кнопку Options/Параметры, в левой части появив-
шегося окна выбрать Customize Ribbon/Настройки ленты, после чего 
нажать на кнопку New Tab/Создать вкладку для создания новой вкладки 
или New group/Создать группу для создания новой панели (рис. 4). Даем 
название нашей вкладке или панельке и добавляем на нее необходимые 
кнопки (по аналогии с панелью быстрого доступа). 

Создание макета 

Для создания нового документа нажимаем кнопку File... (Файл) в 
верхнем левом углу. В левой панельке выбираем New (Создать) и в 
предложенном списке двойным щелчком выбираем Blank Document 
(Новый документ) (рис. 5). 

Далее переходим к настройкам страницы. Заходим на вкладку Page 
loyout (Разметка страницы), в поле Page setup (настройки страницы) 
нажимаем на кнопку дополнительных параметров и в появившемся 
окне переходим на вкладку Paper (Размер бумаги). В поле Paper Size 
(Размер бумаги) выбираем формат А5. Если данного размера нет, то 
выбираем пункт Custom Size (Другой) и задаем размер бумаги: Width 
(Ширина) – 14,85 см и Height (Высота) – 21 см (рис. 6). 
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Рис. 4. Создание новой вкладки 

 

 
Рис. 5. Создание нового документа 

 
В этом же окне переходим на вкладку Margins (Поля). Устанавливаем 

отступ сверху, снизу, справа и слева (не меньше) 2 см (рис. 7). Нажимаем 
на кнопку ОК. 
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Рис. 6. Установка размера страницы 

 

 
Рис. 7. Установка полей 

Колонтитулы 

Разные колонтитулы на четных и нечетных страницах. Для того, 
чтобы задать разные колонтитулы на четных и нечетных страницах, 
необходимо перейти на вкладку Page Layout (Разметка страницы) и в 
поле Page Setup (Параметры страницы) в нижнем правом углу нажимаем 
на кнопку дополнительных параметров. После этого в появившемся окне 
переходим на вкладку Layout (Макет) и ставим галочку напротив 
Headers and Footers Different odd and even (Различать колонтитулы 
четных и нечетных страниц). 
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Рис. 8. Окно Layout (Макет) 

 
Номера страниц. Для того, чтоб вставить номера страниц, переходим 

на вкладку Insert (Вставка). В поле Header & Footer (Колонтитулы) 
нажимаем на кнопку Page Number (Номер страницы) и задаем положение 
Top of Page (Left, Center, Right) или Bottom of Page (Left, Center, Right). 
При необходимости задать дополнительные параметры выбираем пункт 
Format Page Numbers (Формат номера страницы). 

 

 
Рис. 9. Вставка номера страницы в колонтитул 
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Текст. В случае, если необходимо вставить в колонтитулы текст, на 
вкладке Insert (Вставка) в поле Header & Footer (Колонтитулы) нажимаем 
на кнопку Header (Верхний колонтитул) и выбираем пункт Edit header 
(Изменить верхний колонтитул) 

 

 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  

 
Рис. 10. Вставка текста в колонтитул 

 
После этого вы автоматически перемещаетесь в верхний колонтитул, 

где можете смело вводить необходимый текст (данный текст будет 
отображаться на каждой странице). 

Аналогично с нижним колонтитулом. 
К каждому разделу свой колонтитул. Если стала задача каждому 

разделу задать свой колонтитул (например, название данного раздела), то 
необходимо после окончания каждого раздела вставить разрыв раздела. 
Для этого переходим на вкладку Page Layout (Разметка страницы), на 
панели Page setup (Параметры страницы) нажимаем на кнопку Breaks 
(Разрывы) и в появившемся списке выбираем Section break Next page 
(Разрывы разделов Следующая страница) (рис. 11). 

В режиме редактирования колонтитула разрываем связь с колонти-
тулами предыдущего раздела (панель Navigation/Переходы, кнопка Link 
to Previous/Как в предыдущем разделе). При том проделывать данную 
процедуру только с теми колонтитулами, которые собираемся менять 
(верхний, нижний, колонтитулы на правой, левой или первой странице). 

Теперь в новом разделе можно задавать другие колонтитулы. 
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Рис. 11. Вставка разрыва раздела 

Оглавление 

Cтавим курсор в том месте, где должно быть содержание, переходим 
на вкладку References (Ссылки), на панели Table of Contents (Оглавление) 
нажимаем на дополнительные параметры кнопки Table of Contents 
(Оглавление) и выбираем в выпавшем меню пункт Insert Table of Contents 
(Оглавление) (рис. 12). 

Указываем: 
Show page numbers (Показать номера страниц) – да; 
Right align page numbers (Номера страниц по правому краю) – да; 
Tab leader (Заполнитель) – как правило, точки; 
Formats (Форматы) – на ваш вкус; 
Show levels (Уровни) – глубина иерархии ваших разделов. 
Нажимаем кнопку ОК. 
Теперь чтоб занести какое-либо заголовок в содержание, выделяем его 

и на вкладке References (Ссылки) нажимаем на кнопку Add Text (Добавить 
текст) панели Table of Contents (Оглавление) и выбираем уровень: если 
это название раздела, выбираем Уровень 1, если подзаголовка раздела – 
Уровень 2 и т.д. (рис. 13). Когда все разделы добавлены в оглавление, 
возвращаемся к полю оглавления и нажимаем на кнопку Update table 
(Обновить таблицу) на той же панели. В появившемся окне выбираем 
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Update entire table (Обновить целиком) в случае, если надо вывести 
заново названия всех разделов, или Update page numbers only (Обновить 
номера страниц) в случае, если никакие изменения в названия разделов 
не вносились, а менялся лишь текст. Вот и все. 

 

 
Рис. 12. Окно Table of Contents (Оглавление) 

 

 
Рис. 13. Добавление заголовков в оглавление 

 
Можно также сделать оглавление вручную. 
Выделяем набранный текст оглавления, выравниваем его по левому 

краю и нажимаем на кнопку Tabs (Табуляция) (предварительно добавьте 
данную кнопку на одну из панелей). 

Выставляем значения: 
Tab stop position (Позиции табуляции) – приблизительно 10,8 см 

(ширина страницы без полей); 
Alignment (Выравнивание) – right (по правому краю); 
Leader (Заполнитель) – dots (точки). 
Теперь достаточно после заголовка вставить табуляцию (Tab), и 

линия из точек готова. 
Далее текст оглавления форматируется на усмотрение верстальщика. 
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Рис. 14. Установка параметров табуляции 

Основной текст 

Выделяем весь текст и переходим на вкладку Home (Главная). Здесь 
нам понадобятся две панели: Font (Шрифт) и Paragraph (Абзац). 

 

 
Рис. 15. Панели Font (Шрифт) и Paragraph (Абзац) 

 
На них находятся все необходимые инструменты для работы с 

текстом: гарнитура, размер шрифта, начертание, выравнивание... Здесь 
же можно задать межбуквенное расстояние. Выделяем строку, нажимаем 
на кнопку дополнительных параметров в правом нижнем углу панели 
Font (Шрифт) и переходим на вкладку Advanced (Дополнительно). 

 

 
Рис. 16. Установка межбуквенного расстояния 



73 

Для того, чтоб немного разредить межбуквенное расстояние, в поле 
Spacing (Интервал) выбираем Expanded (Разреженный) и устанавливаем 
значение 0,1-0,3 (не более). Для того, чтоб уплотнить межбуквенное 
расстояние, в поле Spacing (Интервал) выбираем Condensed (Уплотненный) 
и устанавливаем значение 0,1-0,3 (не более). 

Чтоб перейти к настройкам абзаца, переходим на вкладку Home 
(Главная) и нажимаем на кнопку дополнительных параметров в правом 
нижнем углу панели Paragraph (Абзац). 

 

 
Рис. 17. Настройка параметров абзаца 

 
Задаем следующие параметры: 
Text alignment (выравнивание текста) – по ширине страницы (justified). 
First line (Отступ красной строки) – 0,5-0,7 см. 
Spacing (Отступы) перед абзацем и после абзаца – 0 пт. 
Line Spacing (Междустрочный интервал) – Single (одинарный). 
С помощью Line Spacing (Междустрочного интервала) можно также 

избавляться от висячих строк. Чтоб «втянуть» одну строку, выделяем 
весь текст на странице и устанавливаем Line Spacing (Междустрочный 
интервал) приблизительно 0,98. Чтоб вытолкнуть одну строку, выделяем 
весь текст на странице и устанавливаем Line Spacing (Междустрочный 
интервал) приблизительно 1,02. 
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Списки 

Выделяем необходимый фрагмент текста и на панели Paragraph 
(Абзац) вкладки Home (Главная) выбираем Bulleted (Маркированный) или 
Numbered (Нумерованный). 

 

 
Рис. 18. Создание маркированного списка 

 
Если нужный вам стиль отсутствует, в выпавшем списке выберите 

пункт Define New Bullet (Define New Bullet) (для маркированных 
списков) или Define New number Format (Define New number Format) (для 
нумерованых списков). 

Отформатировать абзац списка можно так же, как и обычный текст, 
нажав на кнопку дополнительных настроек в правом нижнем углу панели 
Paragraph (Абзац) на вкладке Home (Главная). 

Отрегулировать расстояние между маркером и текстом элемента 
списка можно, выделив текст списка и нажав на кнопку Tabs (Табуляция). 
Далее необходимо удалить существующие положения табуляции (чтоб 
старые не перекрывали новые), нажав на кнопку Clear all (Удалить все). 
Теперь можно задать свои параметры. 

Сноски 

Для того, чтобы вставить сноску, ставим курсор в необходимом 
месте, переходим на вкладку References (Ссылки) и нажимаем на кнопку 
дополнительных параметров в правом нижнем углу панели Footnotes 
(Сноски). 
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Рис. 19. Создание сноски 

 
Выставляем параметры: 
– Location (Положение) – Footnotes: Bottom of page (сноски: Внизу 

страницы) (если необходимо, чтобы текст сноски размещался на той же 
странице) или Endnotes: Bottom of document (концевые сноски: В конце 
документа) (если необходимо, чтобы все сноски размещались в конце 
книги); 

– Number format (Формат номера) – на усмотрение верстальщика; 
– Numbering (Нумерация) – Restart each page (На каждой странице) 

(если необходимо, чтоб на каждой странице нумерация начиналась с 
начала) или Continuous (Продолжить) (если нужна сквозная нумерация); 

– Apply changes to (Применить) – whole document (ко всему документу). 
Нажимаем кнопку Insert (Вставить). 

Специальные символы 

Переходим на вкладку Insert (Вставка) и на панели Symbols (Символы) 
нажимаем кнопку Symbol (Символ). Выбираем нужный символ в списке. 
Далее можно выбрать пункт More symbols (Другие символы). 

Выбираем нужный символ в списке и нажимаем кнопку Insert 
(Вставить). 

По сравнению с предыдущими версиями в Word 2010 добавлено 
много новых специальных символов. 
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Рис. 20. Вставка специального символа 

Формулы 

Переходим на вкладку Insert (Вставка), в поле Symbols (Символы) 
нажимаем на дополнительные параметры Equation (Формула) и в выпавшем 
списке выбираем Insert new Equation (Вставить новую формулу) (доступно 
только для формата *.docx). После этого у нас появляется поле для 
ввода формулы и дополнительная вкладка Design (Конструктор), на 
которой размещены все необходимые математические знаки. 

 
Вкладка Equation Tools – Design/Работа с формулами – Конструктор 

 

Панель Tools/Сервис 
Equition/Формула 
Professional/Профессиональный 
Linear/Линейный 
Normal Text/Обычный текст 
 

 
Панель Symbols/Символы 
Up/Вверх 
Down/Вниз 
More/Дополнительные параметры 
 

 

Панель Structures/Структуры 
Fraction/Дробь 
Script/Индекс 
Radical/Радикал 



77 

Integral/Интеграл 
Large operator/Крупный оператор 
Bracket/Скобка 
Function/Функция 
Accent/Диакритические знаки 
Limit and Log/Предел и логарифм 
Operator/Оператор 
Matrix/Матрица 

 
Далее работаем с формулой как с обычным текстом. 
Для выхода из Мастера формул достаточно нажать левой кнопкой 

мыши по пустому полю. 

Рисунки 

Для вставки рисунка переходим на вкладку Insert (Вставка), на 
панели Illustrations (Иллюстрации) нажимаем кнопку Picture (Рисунок). 
Выбираем необходимое изображение и нажимаем кнопку Insert 
(Вставить). 

Отцентровуем рисунок: выделяем его и на вкладке Home нажимаем 
на кнопку Center (По центру) панели Paragraph (Абзац). 

При работе с изображениями появляется специальная вкладка для 
редактирования. 

 
Вкладка Picture Tool – Format/Работа с рисунками – Формат 
Для формата *.doc вкладка имеет следующие панели: 

 

Панель Adjust/Измерение 
Brightness/Яркость 
Contrast/Контраст 
Recolor/Перекрасить 
Compress Pictures/Сжать рисунки 
Reset Picture/Сброс параметров рисунка 
 

 
 

Панель Shadow Effects/Эффекты 
тени 
Shadow Effects/Эффекты тени 
Nudge Shadow/Сдвинуть тень 
Shadow On/Off/Вкл/выкл тень 
 

 
 

Панель Border/Граница 
Picture Border/Граница рисунка 
Dashes/Штрихи 
Weight/Толщина 
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Панель Arrange/Упорядочить
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 
 
Панель Size/Размер
Crop/Обрезка 
Height/Высота 
Width/Ширина 

 
Для формата *.docx вкладка состоит из следующих панелей: 

 

Панель Adjust/Измерение
Remove Background/Удалить фон 
Correction/Коррекция 
Color/Цвет 
Artistic effects/Художественные эффекты 
Compress Pictures/Сжать рисунки 
Change picture/Изменить рисунок 
Reset Picture/Сброс параметров рисунка 

 

Панель Picture styles/Стили 
рисунков 
Picture border/Граница рисунка 
Picture effects/Эффекты для рисунка 
Picture Layout/Макет рисунка 

 

Панель Arrange/Упорядочить
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 

Панель Size/Размер
Crop/Обрезка 
Height/Высота 
Width/Ширина 

 
При работе со схемами используются следующие вкладки. 
Вкладка Drawing Tool – Format/Средства рисования – формат 
Данная вкладка появляется при работе с автофигурами. 
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Для формата *.doc вкладка состоит из следующих панелей: 

 

Панель Insert Shapes/Вставка 
фигур 
Edit shape/Изменить фигуру 

 

Панель Shape Styles/Стили фигур 
Shape Fill/Заливка фигуры 
Shape Outline/Контур фигуры 
Change Shape/Изменить фигуру 
 

 

Панель Shadow Effects/Эффекты 
тени 
Shadow Effects/Эффекты тени 
Nudge Shadow/Сдвинуть тень 
Shadow On/Off/Вкл/выкл тень 
 

 

Панель 3-D Effects/Объем 
3-D Effects/Объем 
Tilt/Повернуть 
3-D On/Off/Вкл/выкл объем 

 

Панель Arrange/Упорядочить 
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 
 
Панель Size/Размер 
Height/Высота 
Width/Ширина 

 
Для формата *.docx вкладка содержит следующие панели: 

Панель Insert Shapes/Вставка 
фигур 
Edit shape/Изменить фигуру 
Draw textbox/Нарисовать надпись 

 

Панель Shape styles/Стили фигур 
Shape fill/Заливка фигуры 
Shape outline/Контур фигуры 
Shape effects/Эффекты фигур 
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Панель WordArt Styles/Стили 
WordArt 
Text fill/Заливка текста 
Text outline/Контур текста 
Text effects/Анимация 
 

 
 

Панель Text/Текст 
Text direction/Направление текста 
Align text/Выровнять текст 
Create Link/Создать связь 

 

Панель Arrange/Упорядочить 
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 

 
Панель Size/Размер 
Height/Высота 
Width/Ширина 

 
Вкладка Text Box Tools – Format/Работа с надписями – Формат 
Данная вкладка появляется при работе с надписями (только для 

формата *.doc). 

 
 

Панель Text/Текст 
Draw Text Box/Нарисовать надпись 
Text Direction/Направление текста 
Create Link/Создать связь 

 

Панель Text Box Styles/Стили 
надписей 
Shape Fill/Заливка фигуры 
Shape Outline/Контур фигуры 
Change Shape/Изменить фигуру 

 

 

Панель Shadow Effects/Эффекты
тени 
Shadow Effects/Эффекты тени 
Nudge Shadow/Сдвинуть тень 
Shadow On/Off/Вкл/выкл тень 



81 

 
 

Панель 3-D Effects/Объем
3-D Effects/Объем 
Tilt/Повернуть 
3-D On/Off/Вкл/выкл объем 

 

Панель Arrange/Упорядочить
Position/Положение 
Wrap Text/Обтекание текстом 
Bring Forward/Переместить вперед 
Send Backward/Переместить назад 
Selection Pane/Область выделения 
Align/Выровнять 
Group/Группировать 
Rotate/Повернуть 

Панель Size/Размер
Height/Высота 
Width/Ширина 

Таблицы 

Для вставки таблицы необходимо на панели Tables (Таблицы) нажать 
на дополнительные параметры кнопки Table (Таблица) и выделить 
необходимое количесто столбцов и строк или же выбрать пункт Insert 
table (Вставить таблицу). 

 

 
Рис. 21. Вставка таблицы 

 
Задаем количество столбцов и строк и нажимаем кнопку OK. 
При работе с таблицами используется вкладка Table (Таблица), 

которая имеет следующие панели. 



82 

Панель Design/Конструктор 

 

Панель Table Style Options/ 
Параметры стилей таблиц 
Header Row/Строка заголовка 
Total Row/Строка итогов 
Banded Rows/Чередующиеся строки 
First column/Первый столбец 
Last column/Последний столбец 
Banded Columns/Чередующиеся столбцы 

 

 
Панель Table Styles/Стили таблиц 
Styles/Стили 
Shading/Заливка 
Borders/Границы 

 

 

Панель Draw Borders/Рисование 
границ 
Line Style/Стиль пера 
Line weight/Толщина пера 
Pen color/Цвет пера 
Draw Table/Нарисовать таблицу 
Eraser/Ластик

 
Панель Layout/ Макет 

 
 

Панель Table/Таблица 
Select/Выделить 
View Gridlines/Отобразить сетку 
Properties/Свойства 

 

Панель Rows&Columns/Строки и 
столбцы 
Delete/Удалить 
Insert above/Вставить сверху 
Insert Below/Вставить снизу 
Insert Left/Вставить слева 
Insert Right/Вставить справа 
 

 
 

Панель Merge/Объединение 
Merge cells/Объединить ячейки 
Split cells/Разделить ячейки 
Split table/Разделить таблицу 

 

Панель Cell Size/Размер ячейки 
AutoFit/Автоподбор 
Height/Высота строки таблицы 
Width/Ширина столбца таблицы 



83 

Distribute rows/Выровнять высоту строк 
Distribute columns/Выровнять ширину 
столбцов 
 

 
 

Панель Alignment/Выравнивание 
Align/Выровнять 
Text direction/Направление текста 
Cell margins/Поля ячейки 

 

Панель Data/Данные 
Sort/Сортировка 
Repeat header rows/Повторить строки 
заголовков 
Convert to text/Преобразовать в текст 
Formula/Формула
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Создание буклета с помощью 
Adobe Acrobat 

 
Последний этап верстки в Word – создание буклета. 
Для того, чтобы создать буклет, нам понадобится Adobe Acrobat 

Pro и плагин к нему Quite Imposing Plus 2.0c. Качаем и устанавливаем. 
Возвращаемся к созданной нами книге. Нажимаем на клавиши Ctrl + 

P (или же выполняем команду File → Print (Файл → Печать)) и там, где 
указано имя принтера, выбираем Adobe PDF. Нажимаем кнопку OK. 

 

 
Рис. 1. Окно «Print» (Печать) 

 
Далее выбираем, куда сохранить, и снова нажимаем OK. 
После создания документа откроется окно Acrobat’а. 
Шаг 1. Выполняем команду 

Plug-Ins → Quite Imposing Plus 2 → Create Booklet. 
В появившемся окне нажимаем кнопку Next (Далее). 
Шаг 2. Выбираем пункт 3. Make the booklet fit on a sideways a4 size 

page (297 x 210 mm). Scale 100 % (вместить буклет на формат А4). 
Нажимаем кнопку Next (Далее). 

Шаг 3. Выбираем пункт Saddle stitched. All the sheets are placed together 
and folded in half. The front and back pages will appear together on the 
first sheet printed (Сшитые. Все страницы собраны вместе и разделены 
пополам. На первом листе находятся первая и последняя страницы – 
собственно буклет). Нажимаем кнопку Next (Далее). 
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Рис. 3. Окно создания буклета. Шаг 1 

 

 
Рис. 4. Окно создания буклета. Шаг 2 
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Рис. 5. Окно создания буклета. Шаг 3 

 

 
Рис. 6. Окно создания буклета. Шаг 4 
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Шаг 4. Выбираем пункт 1. Interleave (front, back, front 
Normal (use this also if you are printing only one side) 
(Печать (передняя, обратная, передняя. 
Нормальный режим (использовать даже если печатается только 

одна сторона). 
Нажимаем кнопку Next (Далее). 
Шаг 5. Выбираем пункт 1. Centre each page on its half of the sheet. 

Recommended in the most cases (Отцентровать каждую страницу на ее 
половине. Рекомендуется). Нажимаем кнопку Finish (Готово). 

 

 
Рис. 7. Окно создания буклета. Шаг 5 

 
Вот и все. Сохраняем наш буклет. 
 
Примечание. Внести небольшие изменения (например, исправить/ 

удалить букву) можно с помощью программы Foxit PDF Editor. 
 
 
 
 
 

* Перевод авторский 
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Терминологический словарь 
 

ISBN – сокращенное название междунар. стандартного номера книги 
(International Standard Book Number). В книжных изданиях стандарт 
требует печатать ISBN в левом нижнем углу оборота тит. 

ISSN – сокращенное название междунар. стандартной нумерации 
сериальных изданий (International Standard Serial Numbering), т. е. 
журнала, другого периодич. 

АБЗАЦ – в первоначальном значении своем — то же, что и красная 
строка. Но А. означает и отрывок письменной речи, заключенный 
между красными строками. 

АБЗАЦНЫЙ ОТСТУП – пробел в начале первой строки абзаца, наглядно 
подчеркивающий переход к новому текстовому куску.  

АВТОР – физ. лицо, творческим трудом которого создано произведение. 
Не требуется никаких формальностей (регистрации и т. п) для того, 
чтобы считаться автором. 

АВТОРСКИЙ ЗНАК, или Кеттеровский знак, – условное обозначение 
фамилии автора (первого автора, если авторов два или три) или первого 
слова заглавия, один из основных элементов выходных сведений печатного 
издания, введенный известным специалистом библиотечного дела 
Любовью Борисовной Хавкиной. 

АННОТАЦИЯ – Краткая характеристика тематического содержания 
издания (произведения), его социально-функционального и читательского 
назначения, формы и других особенностей. 

АПОСТРОФ – надстрочный знак в виде запятой, набранной на 
верхнюю линию строки. По техн. правилам набора не отбивается от 
предшествующей и последующей буквы. 

БЕЛАЯ СТРОКА – немой заголовок в виде пробельной строки того же 
кегля, что и текст, который она разделяет. 

БИБЛИОТЕЧНО-БИБЛИОГРАФИЧЕСКАЯ КЛАССИФИКАЦИЯ (ББК). 
Рабочие таблицы, предназначены для организации библиотечных фондов, 
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систематических каталогов и картотек. Приказ об образовании редколлегии 
для издания таблиц был издан Министерством культуры РСФСР в 
1959 году. Первый вариант таблиц был разработан и опубликован в 
СССР в 1960-1968 гг. в тридцати томах под названием «Библиотечно-
библиографическая классификация. Таблицы для научных библиотек». 

БРОШЮРА – непериодич. книжное издание объемом свыше 4, но не 
более 48 с. Полиграфисты считают брошюрой любое издание в обложке, 
поскольку производство издания завершается в этом случае брошюро-
вочными процессами. 

БУКЛЕТ (от фр. bouclette – завитушка) – листовое издание, сфальцованное 
(сложенное) в неразрезанную тетрадь. 

ВАКАТ – пустая, без текста страница. 

ВАЛОВАЯ НУМЕРАЦИЯ – сплошная порядковая нумерация сериального 
(периодич., продолжающегося, серийного) издания со дня его основания, 
ведущаяся, в отличие от текущей нумерации, не по годам. 

ВВЕДЕНИЕ – начальная часть или глава произведения, в которой чаще 
всего определяются исходные понятия, осн. термины, обозреваются 
теории, лит. и докум. источники, обосновывается постановка и разработка 
темы. Иногда В. объединяют с предисловием. 

ВГОНКА СТРОК – вид компенсационной корректурной правки вгонкой 
концевых строк абзацев в предшествующие строки. Применяется в 
случаях, когда, напр., вставленный в корректурный оттиск доп. текст 
не умещается в установленное число строк полосы. 

ВЕДУЩИЙ РЕДАКТОР – изд. редактор книги или другого непериодич. 
издания, который отвечает за него в целом, в отличие от редакторов 
худож. и техн., ответственных лишь за одну из сторон издания. 

ВЕРСТКА – составление страниц (полос) газеты, журнала, книги 
определенного формата в соответствии с разметкой или макетом, 
оттиск (корректура) со сверстанного набора, предназначенный для 
исправления ошибок. 
В. подчиняется техн. правилам В. Согласно осн. из этих правил, В. 
должна быть: 1) единообразной – высота всех полос одинакова и кратна 
кеглю шрифта осн. текста, отбивки от текста различных элементов 
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(сноски, иллюстрации, подписи к ним, таблицы, формулы и т. д.) 
идентичны; размер спуска одинаков во всем издании ± 1 строка; 
2) приводной, т. е. такой, при которой строки осн. текста совпадают с 
соотв. строками на обороте, для чего все части полос, набранные 
иначе, чем осн. текст, или занятые иллюстрациями, таблицами и т. д., с 
помощью отбивок приводят по высоте к целому числу строк осн. 
текста; 3) без висячих строк на полосах. 

ВИД ИЗДАНИЯ – группа изданий, обладающих одинаковыми сущест-
венными типовыми (видовыми) признаками: 
1) социально-функциональным назначением (учеба, совершенствование 
производства, развитие науки, эстетическое наслаждение, наведение 
справок, информация о документах, развлечение и т. д.); 
2) материальной конструкцией (книжное, листовое, комплектное 
издание); 
3) читательским адресом (для читателей всех или почти всех возрастов, 
для детей, для взрослого читателя); 
4) знаковой формой информации (главным образом текст, или изображения, 
или нотная запись, или картографическое произведение); 
5) связанностью или несвязанностью с другими изданиями и временны́ми 
особенностями выпуска (непериодич. или сериальное – периодич., 
продолжающееся, серийное издание). 

ВИСЯЧАЯ СТРОКА – концевая строка абзаца, стоящая первой на 
полосе или в колонке, или начальная строка абзаца, стоящая на полосе 
(в колонке) последней. Верхняя висячая строка. Нижняя висячая строка. 
Техн. правила верстки не допускают обоих видов В. 

ВИСЯЧЕЕ ТИРЕ – тире после начальной даты еще не закончившегося 
периода, неизвестная конечная дата которого заменяется пробелом, 
равным числу знаков первой даты. 

ВИСЯЧИЙ ДЕФИС – дефис в конце начальной части слова, заменяющий 
его вторую часть, которая повторяется в следующем, одинаково 
построенном с первым слове. 

ВКЛАДЫШ – отдельно напечатанное и сброшюрованное небольшое 
(немногостраничное) приложение к изданию, вложенное в него между 
страницами текста, форзаца либо между сторонкой обложки и страницей 
издания или в приклеенный изнутри к сторонке переплета. 
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ВНУТРИБУКВЕННЫЙ ПРОСВЕТ – расстояние между осн. штрихами 
букв и знаков шрифта, один из его графических признаков. 

В ПОДБОР – набор текста не с абзацного отступа или с новой строки, 
а непосредственно вслед за предшествующим текстом.  

ВЫГОНКА СТРОК – вид компенсационной корректурной правки, 
когда на полосе по к.-л. причине не хватает строк, приемы образования 
доп. концевых строк абзацев.  

ВЫДЕЛЕНИЯ – вид подчеркивания элементов текста (букв, слогов, 
слов, предложений) с помощью отличного от остального текста их 
оформления, чтобы упростить чтение, активизировать запоминание 
терминов или других текстовых элементов, убыстрить их поиск. 

ВЫКЛЮЧКА СТРОКИ – операция разгонки или сжимания набранной 
строки до формата набора увеличением или уменьшением междусловных 
пробелов, реже межбуквенных просветов. 

ВЫНОСКА – примечание, комментарий, библиогр. ссылка, вынесенные 
за осн. текст и связанные с ним к.-л. Образом. 

ВЫНОСКИ ЗНАК – условное обозначение, которым связывают фрагмент 
осн. текста с относящимся к нему затекстовым материалом: примечанием, 
комментарием, библиогр. ссылкой. 

ВЫПУСК – отдельно изданная часть (печ. единица) сериального 
(периодич., продолжающегося, серийного) издания, имеющая свой 
порядковый номер или частное заглавие. 

ВЫПУСКНЫЕ ДАННЫЕ – часть выходных сведений, в которой дается 
производственно-техн. характеристика издания, даты его прохождения 
в производстве, названия и адреса изд-ва и типографии. 

ГАРНИТУРА – комплект шрифтов одного рисунка, но разных размеров 
(кеглей) и начертаний. 

ГЛАВА – рубрика произведения; как правило, основная в системе 
рубрикации. Г. может быть разделена на подглавы, параграфы, подпа-
раграфы и объединена с другими главами в более крупные рубрики – 
разделы, части. 
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ГЛАВНЫЙ РЕДАКТОР – возглавляющий издание или изд-во редактор, 
который определяет редакционную политику печ. органа или изд-ва и 
руководит всей редакционной работой органа или изд-ва. 

ГОД ВЫПУСКА ИЗДАНИЯ – последний элемент выходных данных 
издания. Им считается год выпуска в обращение экземпляров произведения 
(издания), т. е. год сдачи тиража или его начальной партии книготорговцу. 

ГРИФ – часть выходных сведений, данные о том, что издание 
утверждается, допускается к использованию или рекомендуется в 
качестве официального, нормативного, учебного издания. 

ДЕФИС – знак в виде короткой черточки, применяемый для соединения 
частей сложных слов, которые пишутся по правилам орфографии через Д. 
От соединяемых частей не отбивается. 

ДИАГРАММА – изображение, наглядно показывающее соотношение 
между различными количествами или между значениями одной и той 
же величины в разные моменты времени. 

ЗАГЛАВИЕ – название лит. произведения, издания, серии, подсерии, 
определяющее тему, идею, предмет, центральный образ.  

ЗАГОЛОВОК – название внутреннего подраздела произведения (главы, 
параграфа, части, раздела) или издания (раздела, части, элементов 
аппарата); название структурной части рубрики вспом. указателя, 
обозначающей объект поиска; название структурной части рубрики 
вспом. указателя, обозначающей объект поиска; название, определяющее 
номер и тему таблицы, содержание ее строк и граф. 

ЗАСЕЧКИ, или серифы, – графически выделенные нижние и верхние 
окончания штрихов в буквах и знаках типографского шрифта.  

ЗЕРКАЛЬНОЕ ИЗОБРАЖЕНИЕ, или Обратное изображение, – изо-
бражение, повторяющее в точности другое, но в зеркальном виде. 

ИЗОБРАЖЕНИЕ – элемент издания, передающий к.-л. содержание 
наглядными, графическими средствами (иллюстрации) или служащий 
украшением, созвучным изданию и усиливающим разграничение его 
структурных частей. 
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ИЛЛЮСТРАЦИЯ – изображение в издании, поясняющее текст, 
помогающее читателю лучше понять его благодаря своей наглядной 
изобразительной форме или дополняющее текст, выражающее содержание, 
которое либо вообще нельзя передать в текстовой форме, либо передать в 
ней гораздо сложнее, а воспринимать намного труднее. 

ИМЯ АВТОРА – сведения о фамилии и имени (имени и отчестве) или 
его (их) инициалах в выходных сведениях или библиогр. описании 
(библиогр. записи) издания. 

ИНДЕКС – под- и надстрочный знак. 

ИНИЦИАЛ – сокращенное до одной первой буквы имя и (или) отчество. 

КАВЫЧКИ – парный знак препинания, употребляемый для выделения 
названий, прямой речи, цитат, для подчеркивания ироничного исполь-
зования слова или словосочетания и др. 

КАПИТЕЛЬ – шрифт, буквы которого по начертанию прописные, а по 
высоте строчные.  

КВАДРАТНЫЕ СКОБКИ, или прямые скобки, – парный знак препинания. 
К. с. в тексте изданий используются в следующих случаях: 1) для 
выделения в тексте цитат мелких, не оговариваемых замечаний и 
расшифровок местоимений; 2) для того, чтобы заключить в них текст, 
внутри которого уже употреблены круглые скобки. 

КЕГЛЬ (КЕГЕЛЬ) – размер литеры наборного шрифта в стоячем 
положении от передней до задней стенки. Практически К. – это высота 
буквы или знака в строке с просветом над и под ними (заплечики), 
необходимым для того, чтобы их штрихи в смежных строках не 
сливались друг с другом. 

КОЛОНКА, или столбец, – часть полосы при многоколонной верстке 
издания, образуемая строками, которые набраны на формат, составляющий 
определенную долю от общего формата набора полосы, и отделенная 
от смежной колонки вертикальным пробелом – средником. 

КОЛОНТИТУЛ – заголовочные данные (название произведения, 
части, главы, параграфа и т. п.), помещаемые над или под текстом на 
нескольких или на всех страницах книги, газеты, журнала или другого 



94 

многостраничного издания. Различаются верхний и нижний колонтитулы. 
Текст колонтитула, в отличие от остальных заголовков и надписей, 
может повторяться на нескольких страницах, например на каждой 
странице раздела, реже – всего издания. 

КОЛОНЦИФРА – порядковый цифровой номер страницы издания или 
столбца (при нумерации по столбцам). Располагают К. в нижнем или 
верхнем поле страницы (редко в боковом наружном поле) в самых 
разных местах: от края набора и т. д., на разном расстоянии от края 
набора, руководствуясь шагом модульной сетки или произвольно 
выбранным отступом. 

КОНЦЕВАЯ СТРОКА АБЗАЦА – последняя строка абзаца, которая, как 
правило, заканчивается концевым пробелом. По техн. правилам набора 
текст концевой строки должен превышать размер абзацного отступа не 
меньше чем в полтора раза. 

КОНЪЕКТУРА – исправление ошибки в тексте произведения не по его 
источникам, а на основании анализа контекста и доказательного 
объяснения того, откуда проистекла ошибка и почему это именно 
ошибка, описка, а не намеренное искажение текста автором. 

КОПИРАЙТ (от англ. copyright – авт. право), или знак охраны авт. 
права, или конвенционный знак, – знак, которым обладатель исключи-
тельных авт. прав оповещает о своих. 

КОРРЕКТОР – работник изд-ва или типографии, выполняющий 
корректуру. В задачу изд. К. входит: 1) сверить текст набора с текстом 
оригинала, чтобы устранить все отклонения от последнего; 2) исправить 
орфографические и пунктуационные ошибки, пропущенные при считке и 
вычитке; 3) устранить нарушения техн. правил набора и верстки или 
обратить на них внимание редактора и техн. редактора; 4) пометить 
для редактора и автора все не замеченные ими в оригинале смысловые, 
логические, фактические и иные ошибки. 

КОРРЕКТУРА – исправление ошибок и неисправностей, допущенных 
исполнителями при наборе и репродуцировании оригиналов или не 
замеченных автором и изд. работниками при подготовке оригиналов, а 
также обновление материалов, устаревших за время набора, и такие же 
исправления в самом наборе. 
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КОРРЕКТУРНАЯ ПРАВКА – правка в корректурных оттисках, которая 
по тому, по чьей вине она вносится, делится на авторскую (автора и 
художника), корректорскую (изд. корректора), редакторскую и типо-
графскую. 

КОРРЕКТУРНЫЕ ЗНАКИ – условные графические обозначения действий, 
которые нужно выполнить правщику набора (заменить одну или несколько 
букв или слов другими, вставить или выбросить знаки, буквы, слова и 
т. д). 

КРАСНАЯ СТРОКА – 1. В рукописной книге начальная строка абзаца, 
выделенная красным цветом (отсюда само название). 2. В современном 
изд. деле и полиграфии любая неполная строка, поставленная по центру, 
посередине формата набора (в красную строку). 

КРАТКОЕ ОГЛАВЛЕНИЕ (СОДЕРЖАНИЕ) – оглавление, включающее 
заголовки только 1-й или 1-й и 2-й ступени рубрикации при большем 
числе ступеней, и содержание, включающее только заголовки разделов 
сборника или тома собр. соч. 

КУРСИВНОЕ НАЧЕРТАНИЕ, или курсив (от позднелат. cursivus – 
бегущий), – начертание, для которого характерен наклон осн. штрихов 
справа налево сверху вниз и сходство с рукописным почерком. 

ЛЕГЕНДА – 1. Пояснительная часть изображения со справ. сведениями, 
расшифровкой условных обозначений и т. п. 2. Часть подписи к 
иллюстрации, в которой сообщаются сведения о месте хранения оригинала, 
его худож. и техн. особенностях, дате создания и т. п. 3. В карте свод 
условных знаков с их пояснениями. 

ЛИСТ – единица объема издания.  

ЛИТЕРАТУРНОЕ РЕДАКТИРОВАНИЕ – редакторский анализ, оценка и 
совершенствование совместно с автором лит. формы произведения, 
составная часть редактирования, выделяемая лишь при разделении труда.  

ЛИТЕРАТУРНЫЙ РЕДАКТОР – редактор, который анализирует, 
оценивает и исправляет главным образом или только лит. форму 
произведения, т. е. занимается лит. редактированием, а иногда и вычиткой. 
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МАКЕТ – модель издания, его худож. оформления в целом или только 
обложки, верстки. 

МЕЖБУКВЕННЫЙ ПРОСВЕТ – расстояние между осн. штрихами 
соседних букв в шрифте, разное в зависимости от очертания соседних 
букв на стыке; в хорошем по рисунку шрифте, несмотря на это, 
создается впечатление равномерного расположения букв. 

МЛАДШИЙ РЕДАКТОР – работник редакционного аппарата изд-ва, в 
обязанности которого входит техн. подготовка изд. оригиналов к 
производству (считка их с авт. оригиналом после перепечатки, подчистка 
страниц – исправление ошибок машинистки, – нумерация страниц, 
подготовка дубликатов и т. п.); ведение редакционной картотеки и 
контроль за графиком движения изданий; выполнение поручений ведущего 
редактора, подготовка расчетов с авторами. 

МНОГОКОЛОННАЯ ВЕРСТКА – верстка полос в две, три и более 
колонки.  

МНОГОТОЧИЕ – знак препинания, который употребляется с целью: 
1) обозначить незаконченность высказывания, заминку или перерыв в 
речи и т. п.; 2) обозначить паузу при неожиданном переходе от одной 
мысли к другой между предложениями; 3) указать в начале текста, что 
продолжается речь, прерванная большим отступлением; 4) обозначить 
пропуск слов в цитате. 
По техн. правилам набора М. следует набирать без отбивки от 
предшествующего слова и с отбивкой от последующего, когда оно не 
начинает фразу, и, наоборот, с отбивкой от предшествующего слова с 
точкой или другим знаком на конце (?!) и без отбивки от последующего 
слова, когда многоточие начинает фразу. 

МНОГОТОЧИЕ В УГЛОВЫХ СКОБКАХ – знак, которым принято 
обозначать пропуск нескольких или даже больше фраз в докум. тексте 
или цитате. Набирают этот знак с отбивкой от предшествующего и 
последующего текста, сохраняя предшествующую точку. 

НАДСТРОЧНЫЙ ЗНАК, или надстрочный элемент, – знак малого 
кегля, устанавливаемый в металлическом наборе подключкой над 
символами или цифрами в формулах. 

НАУЧНЫЙ РЕДАКТОР – редактор, выполняющий науч. редактирование 
авт. оригинала.  
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НАЧАЛЬНАЯ СТРОКА – строка, с которой начинается текст произ-
ведения, его подраздела, каждый абзац.  

НЕНУМЕРОВАННЫЕ СТРАНИЦЫ – страницы с текстом или иллюст-
рациями без колонцифры, не вошедшие в общую пагинацию издания.  

НЕПЕРИОДИЧЕСКОЕ ИЗДАНИЕ – издание, которое либо не продол-
жается, является разовым, либо, если и продолжается, как, напр., 
многотомное собр. соч., то заранее рассчитано на определенное число 
томов и рассматривается как единое издание. 

НИЖНЯЯ ЛИНИЯ ШРИФТА – воображаемая горизонтальная линия, 
проходящая по нижним краям нижних выносных элементов.  

НОВОСТРОЧИЕ – текст, начинающийся с новой строки, а не в подбор 
к предшествующему тексту. 

НОМЕРА ЗНАК – знак, обозначающий, что следующее за ним число 
или числа – это номер или номера. Н. з. не следует удваивать перед 
несколькими (многими) номерами. По техн. правилам набора Н. з. 
следует отбивать от следующей цифры. 

НОМЕР ВЫПУСКА (ТОМА) – порядковое число, присваиваемое каждому 
выходящему выпуску (тому) сериального или многотомного издания.  

НУМЕРАЦИЯ – простановка последовательных цифровых порядковых 
номеров. Нумеруют страницы издания (пагинация), элементы внутри 
издания и его текста (заголовки, иллюстрации, таблицы, библиогр. 
ссылки, примечания и комментарии, формулы)… 

НУМЕРАЦИЯ СТРОК – присвоение строкам осн. текста в издании 
классического произведения порядковых номеров для удобства ссылок 
на них в посвященных им работах, в затекстовых комментариях и 
примечаниях. 

ОГЛАВЛЕНИЕ – это указатель заголовков издания. В отличие от 
содержания, оглавление раскрывает в первую очередь строение 
произведения в моноиздании или только строение сборника (из каких 
частей или разделов он состоит).  

ОПЕЧАТКА – ошибка, обнаруженная в уже отпечатанном издании: 
пропуск буквы или лишняя буква, пропуск слова, искажение слова и т. п.  
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ОРИГИНАЛ – в изд. деле источник издания, включающий его текст, 
изображения и т. д.  

ОСНОВНОЙ ТЕКСТ – текст публикуемых в издании произведений, в 
отличие от доп. текста (напр., приложений) и вспом. текста. 

ОТВЕТСТВЕННЫЙ РЕДАКТОР – авторитетный редактор важного в 
к.-л. отношении издания, который отвечает за его подготовку и выпуск, 
руководит работой над ним авторов и других редакторов, в сущности, 
главный редактор издания, чаще всего непериодического. 

ОТТОЧИЕ – ряд разделенных пробелами в полукегельную или кегельную 
точек, которым связывают заголовок боковика со строкой вывода или 
заголовок оглавления (содержания) с отстоящей от него адресной ссылкой. 

ПАРАНТЕЗ – фигурная скобка. 

ПЕРЕВОДЧИК – автор переводного произведения, владеющий правом 
на осуществленный им перевод. 

ПЕРИОДИЧЕСКОЕ ИЗДАНИЕ – сериальное издание, выпуски которого 
выходят через равные промежутки времени (ежедневно, через день, 
раз в неделю, раз в две недели, ежемесячно и т. д) каждый год 
определенным числом, не повторяются по содержанию, нумерованы и 
(или) датированы, однотипно оформлены и имеют одинаковое общее 
заглавие. 

ПЕЧАТНЫЙ ЗНАК – единица исчисления объема текста издания в 
авт. или учетно-изд. л., за которую принимается любой видимый знак 
(буква, цифра, знак препинания, знак переноса и т. п), а также пробел 
между словами. 

ПЕЧАТНЫЙ ЛИСТ – единица натурального объема изданий и печати, 
равная половине запечатанного стандартного бумажного листа (стан-
дартного, а не любого, т. к. лист может быть и двойной ширины). 

ПОДЗАГОЛОВОК – доп. заголовок, который уточняет, поясняет или 
дополняет осн. заголовок. П. либо заключают в круглые скобки, либо 
помещают отд. строкой, набранной шрифтом меньшего, чем заголовок, 
кегля. 
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ПОДСТРОЧНЫЕ ЗНАКИ – цифры или буквы, набранные на линию 
нижних выносных элементов символов, к которым они относятся. По 
техн. правилам набора должны набираться без отбивок от символа или 
цифры. 

ПОСЛЕДНЯЯ СТРАНИЦА ИЗДАНИЯ – страница, которая завершает 
издание и содержит обычно макет аннотированной каталожной карточки, 
предвыпускные и выпускные данные. 

ПРАВКА – процесс и сами изменения текста произведения на всех 
этапах его подготовки к изданию. 

ПРЕДВЫПУСКНЫЕ ДАННЫЕ, или надвыпускные данные, – часть 
выходных сведений, размещаемых обычно над выпускными данными 
(иногда перед ними на предшествующей странице) и содержащих повтор 
самых важных сведений об издании (об авторах, заглавии, составителях), 
а также сведения об изд. работниках, подготовивших издание. 

ПРЕДМЕТНЫЙ УКАЗАТЕЛЬ – вспом. указатель, в заголовках рубрик 
которого названы предметы; сведения о них содержатся в тексте 
издания и могут быть потенциальным объектом поиска. 

ПРИЛОЖЕНИЕ – доп. к осн. тексту материалы справ., докум. или 
иного характера, как правило обогащающие издание.  

ПРИМЕЧАНИЯ – сравнительно краткие дополнения к осн. тексту или 
пояснения небольших фрагментов его, носящие характер справки и, 
как правило, не содержащие, в отличие от комментариев, толкования 
этих фрагментов. 

ПРОБЕЛ – незапечатанный промежуток между оттиснутыми печатающими 
элементами. 

ПРОСТОЙ ТЕКСТ – текст, не содержащий сложных элементов: таблиц, 
формул, слов и словосочетаний на иностр. языках, сносок, библиогр. 
описаний, выделений разного рода, внутритекстовых заголовков и т. д. 

ПРОЦЕНТОВ ЗНАК – знак %, употребляемый только с числами в 
цифровой форме. Вопреки техн. правилам набора должен быть отбит 
от числа, к которому относится, на полукегельную (отбивка при выключке 
не меняется). 
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ПУНКТ – единица типометрической типографской системы, равная 
0,376 мм. 

РАЗВОРОТ – две соседние страницы раскрытого издания, левая и правая. 

РАЗВОРОТНЫЙ КОЛОНТИТУЛ – рубрикационный колонтитул, в 
котором части одного заголовка поделены между левой и правой полосой – 
в левом колонтитуле помещена первая часть заголовка (напр. родо-
нумерационная), а в правом — вторая часть (напр., тематическая). 

РАМКА – прямоугольное графическое изображение из линеек, орнамента, 
замыкающее и окаймляющее текст или иллюстрации и резко отделяющее 
или выделяющее их на полосе. 

РЕДАКТИРОВАНИЕ – 1. Процесс, главная цель которого – на основе 
анализа предназначенного к изданию произведения установить меру 
его общественной ценности и торговых перспектив, т. е. меру соответствия 
содержания и формы этого произведения его общественному, социально-
функциональному назначению и читательскому адресу, сравнивая 
прогнозируемое воздействие произведения на читателя в целом и в 
деталях с тем, каким ему, на взгляд редактора, быть желательно, и 
качества, которыми произведение обладает, с теми, какие могут 
обеспечить ему успех на книжном рынке, а также помочь автору 
пригодного к изданию произведения усилить его достоинства и устранить 
недостатки, выявленные в процессе редакторского анализа. 

РЕДАКТОР – лит. работник, профессионально занимающийся редак-
тированием. 

РЕЦЕНЗЕНТ – автор рецензии, которым в изд. практике может быть 
сотрудник изд-ва или внештатный специалист в той области, к которой 
относится рецензируемое произведение. 

РУБЛЕНЫЕ ШРИФТЫ, или гротесковые шрифты, – шрифты без 
засечек с осн. и соединительными штрихами либо одной толщины и 
полным отсутствием контрастности, либо с малозаметной разницей в 
толщине штрихов и с очень малой контрастностью. 

СВЕРКА – корректура сверочных листов для проверки того, как 
выполнены корректурные исправления в сверстанных листах. 
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СВЕРСТАННЫЕ ЛИСТЫ – сформированные в печ. листы полосы набора 
и корректурные оттиски с них. 

СЕРИЙНОЕ ИЗДАНИЕ – издание, входящее в серию, один из выпусков 
серии. 

СЕРИЯ – совокупность изданий, объединенных общей темой, целью, 
читательским назначением, выходящих под общим заглавием и в 
однотипном оформлении. 

СИГНАЛЬНЫЙ ЭКЗЕМПЛЯР – экземпляр издания из числа первых 
изготовленных типографией экземпляров, присылаемый в изд-во для 
контроля и утверждения в качестве образца для изготовления всего тиража. 

СИМВОЛ – в изд. деле условное в виде буквы обозначение величины, 
понятия, названия хим. элемента в тексте издания и в формулах. 

СКВОЗНАЯ НУМЕРАЦИЯ – порядковая нумерация элементов издания 
(заголовков, иллюстраций, таблиц, формул, сносок, выносок) от начала 
до конца издания или валовая нумерация сериальных изданий. 

СКОЛЬЗЯЩИЙ КОЛОНТИТУЛ – колонтитул, меняющийся от страницы 
к странице. 

СЛОЖНЫЙ ТЕКСТ – текст, сложный в наборе: с разнообразными 
выделениями, дробными выражениями, приставными знаками, подклю-
чками, надстрочными и подстрочными знаками, индексами, показателями 
степени и т. п. 

СМЕШАННЫЙ ТЕКСТ – текст, содержащий помимо слов и символов 
на языке издания слова и символы на одном или нескольких других 
языках. 

СМЕШИВАЕМЫЕ БУКВЫ И ЗНАКИ – буквы, цифры и знаки, близкие 
по начертанию и потому нередко ошибочно принимаемые при наборе 
друг за друга. 

СНОСКА – помещаемые внизу полосы примечание, библиогр. ссылка, 
перевод иноязычного текста, связанные с осн. текстом знаком С. 
С. обычно набирают шрифтом пониженного кегля по сравнению с 
шрифтом осн. текста и отделяют от него пробелом или пробелом с 
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тонкой короткой линейкой (обычно ее длина 1 кв.). Отбивка С. от осн. 
текста – в пределах 1-2 кегельных. Она должна быть такой, чтобы высота 
С. вместе с отбивкой и линейкой была кратной кеглю шрифта осн. текста. 

СНОСКИ ЗНАК – условное обозначение, которым связывают фрагмент 
осн. текста с относящейся к нему сноской. С. з. ставят после фрагмента 
осн. текста и перед относящейся к нему сноской. 

СОДЕРЖАНИЕ – указатель заголовков издания. В отличие от оглавления, 
содержание представляет прежде всего состав полииздания (какие 
произведения в него включены) или состав моноиздания – издания 
одного произведения (какие части, кроме этого произведения, в него 
вошли, напр, части аппарата).  

СПИСОК – перечень к.-л. сведений в издании: библиогр. записей или 
библиогр. описаний (библиогр. список), сокращений и условных 
обозначений, иллюстраций, таблиц и т. д. 

СПЛОШНОЙ ТЕКСТ – текст, не прерываемый выключенными в отд. 
строки формулами, таблицами, заголовками, иллюстрациями. 

СРЕДНИК – пробел между колонками набора при верстке в две и 
более колонки. Нижний предел размера С.: не менее 16 п. (6 мм). 

ТАБЛИЦА – особая форма передачи содержания, которую отличает от 
текста организация слов и чисел в колонки (графы) и горизонтальные 
строки таким образом, что каждый элемент является одновременно 
составной частью и строки, и колонки. 

ТЕКСТ – информация, выраженная с помощью слов, объединенных в 
предложения, образующие фразы, сверхфразовые единства, наконец, 
произведение. 

ТЕКСТОВОЙ КОЛОНТИТУЛ – скользящий колонтитул, выражающий 
осн. тему (осн. темы) материала страницы, сформулированную на основе 
обобщения ее содержания, ее текста. 

ТЕКСТОВЫЙ РЕДАКТОР – компьютерная программа для создания, 
обработки, форматирования текста (текстовых документов). Наиболее 
распространены Т. р. Microsoft Word, WordPad. 
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ТЕХНИЧЕСКИЙ РЕДАКТОР – работник изд-ва, занимающийся техн. 
редактированием издания. Т. р. проверяет, насколько оригиналы издания 
соответствуют нормативным требованиям к ним, и в случае расхождений 
возвращает их для доработки в редакцию. 

ТЕХНИЧЕСКОЕ РЕДАКТИРОВАНИЕ – художественно-техн. руко-
водство детальным воплощением в материале худож. замысла издания 
(проекта его оформления) и контроль за исполнением типографией 
всех художественно-оформительских указаний изд-ва, а также за 
соблюдением техн. правил набора и верстки. 

ТИРАЖ – общее число экземпляров издания. 

ТИРЕ – знак препинания, употребляемый также как условный знак 
замены повторяемых слов в идущих подряд заголовках рубрик и 
подрубрик вспом. указателя.  

ТИТУЛЬНЫЙ ЛИСТ – как правило, начальный книжный лист изданий, на 
котором размещают осн. выходные сведения, титулующие издание, 
позволяющие отличить его от всех прочих, т. е. идентифицировать, и 
служащие осн. источником для библиогр. описания. 

ТОМ – отд. единица многотомного непериодич., периодич. или 
продолжающегося издания, представляющая собой относительно 
самостоятельное издание, либо объединение неск. отд. выпусков, книг 
периодич. или продолжающегося издания. 

ТУПАЯ СТРОКА – на профессиональном языке наборщиков начальная 
строка абзаца без абзацного отступа или полная концевая строка (без 
концевого пробела). 

УГЛОВЫЕ СКОБКИ, или ломаные скобки, – парный знак, в который 
заключают многоточие, показывающее в цитате купюру, составляющую 
либо целое предложение или фразу, либо несколько предложений (фраз). 

УДОБОЧИТАЕМОСТЬ ШРИФТА – качество восприятия читателем 
набранного шрифтом текста.  

УНИВЕРСАЛЬНАЯ ДЕСЯТИЧНАЯ КЛАССИФИКАЦИЯ КНИГ (УДК) – 
иерархическая комбинационная система библиотечно-библиогр. клас-
сификации, разработанная в 1895–1905 гг. в Междунар. библиогр. 
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институте в Брюсселе под руководством Поля Отле и Анри Лафонтена 
и широко применяемая в мире. 

УСЛОВНЫЙ ПЕЧАТНЫЙ ЛИСТ, или приведённый печ. л., – печ. л. 
формата 60×90 см, к которому приравниваются (при помощи коэф-
фициентов перевода физ. печ. л. в условные) печ. л. других форматов. 

УЧЕТНО-ИЗДАТЕЛЬСКИЙ ЛИСТ, или изд. л., – единица объема 
издания, равная, как и авт. л., 40 000 печ. знаков прозаического текста 
(считая и знаки препинания, и пробелы между словами, и неполные 
строки за полные), или 700 строкам стихотворного текста, или 3 000 см2 
площади изображений в том масштабе, в котором они воспроизведены 
в издании. 

ФИЗИЧЕСКИЙ ПЕЧАТНЫЙ ЛИСТ – печ. л. натурального размера, 
который зависит от формата бумажного л., разного в изданиях, напе-
чатанных на разной по формату бумаге. 

ФОРМАТ БУМАГИ – размер бумажного листа по ширине и высоте. 
Стандартные Ф. б., см: 60×84. 70×90. 70×100. 60×90 (60×88). 75×90. 84×108. 

ФОРМАТИРОВАНИЕ ТЕКСТА – в компьютерном наборе изменение 
внешнего вида текста, его частей: шрифтового оформления (гарнитура, 
начертание и кегль шрифта, выравнивание текста по левому или правому 
краю либо по центру, изменение ширины набора и размера абзацного 
отступа и т. п.); преобразование текста в строки, абзацы и полосы. 

ЧАСТЬ – одна из самых крупных (старших) рубрик (подразделов), 
которая может состоять из разделов и в свою очередь объединяться в 
книги из нескольких частей. 

ШАПКА – в книжных изданиях и журналах заголовок, расположенный 
вверху спусковой полосы, второй по значимости после шмуцтитула 
вид заголовка по расположению относительно текста. 

ШМУЦТИТУЛ – 1) лист, на лицевой странице которого (правая 
страница разворота) размещается только заглавие произведения или 
заголовок части, иногда сопровождаемые изображением, эпиграфом, 
заголовками подчиненных подразделов, а оборот – либо оставлен чистым, 
либо запечатан текстом (занят начальной страницей произведения или 
подраздела); 2. Заглавие или заголовок, размещенный на лицевой странице 
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листа, называемого Ш., самый старший по значимости заголовок среди 
тех, которые различаются по расположению относительно текста. 

ШРИФТ – средство передачи текста в издании. 

ЭКСПЛИКАЦИЯ – составная часть подписи к иллюстрации, содержащая 
расшифровку условных обозначений деталей и частей изображения. 

ЭПИГРАФ – предпосланный произведению или его части текст, 
которым автор поясняет, выражает свой замысел, свою цель, ведущую 
идею, используя для этого нередко афористичные цитаты, пословицы 
и поговорки, идиоматические выражения. 

ЯЗЫК ИЗДАНИЯ – язык осн. текста издания. 

 

slovari.yandex.ru 
ru.wikipedia.org 
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Приложение 1 
 

КОРРЕКТУРНЫЕ ЗНАКИ 

Знак Описание Пример 
Заменить букву 
или знак 
другими 

Заменить 
несколько букв, 
знаков, слов, 
целую строку 
другими 

 

 
Заменить 
несколько строк 
другими 

 
Вставить в 
слово 
пропущенную 
букву, буквы, 
знаки 
Вставить слово, 
словосочетание, 
предложение, 
строку 

Используются знаки замены, к 
которым присоединяется знак 
выкидки 

Знаки выкидки 
букв, слогов, 
слов, строк 

 
Поменять 
местами 
соседние буквы, 
слоги, слова, 
строки 
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дужки с номерами, в порядке 
которых надо расставить слова 
или строки. 

Изменить 
порядок 
нескольких 
слов или строк 

 

 
Переставить 
букву, слог, 
слово, 
словосочетание, 
строку, 
несколько строк 
в другое место 

Подвинуть 
элемент вправо, 
влево, вверх, 
вниз до 
нужного места  

 

(второй – для зарубежных 
типографий) 

Начать строку с 
абзацного 
отступа 

 
Соединить 
абзацы в один 
(набрать абзацы 
в подбор) 

 

 Поставить 
элемент 
посередине 
формата 
полосы или 
колонки 
(выключить в 
красную 
строку) 

 

 
Увеличить 
пробел между 
словами или 
строками 

 
Уменьшить 
пробел между 
словами или 
строками 
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Разделить 
пробелом 
слитно 
набранные 
слова 

 

 
Слить в одно 
слово раздельно 
набранные его 
части 

 

 
Выровнять 
междусловные 
пробелы 
Набрать 
шрифтом 
другой 
гарнитуры, 
начертания, 
кегля 

 Выровнять край 
набора 

. . . . . . . . . . Знак отмены 
сделанного 
исправления  
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Приложение 2 
 

НЕКОТОРЫЕ СИМВОЛЫ ASCII 

Символ Описание Сочетание клавиш
- Дефис alt + 45 
– Тире alt + 0150 

— Длинное тире alt + 0151 
" Английские кавычки alt + 34 
„ Открывающаяся нижняя двойная 

кавычка 
alt + 0132 

“ Открывающаяся верхняя двойная 
кавычка 

alt + 0147 

” Закрывающаяся двойная кавычка alt + 0148 
« Открывающаяся «кавычка-елочка» alt + 0171 
» Закрывающаяся «кавычка-елочка» alt + 0187 
‘ Открывающаяся одинарная кавычка alt + 0145 
’ Закрывающаяся одинарная кавычка, 

апостроф 
alt + 0146 

' Апостроф alt + 39 
` Апостроф alt + 96 
[ Открывающаяся квадратная скобка alt + 91 
] Закрывающаяся квадратная скобка alt + 93 
{ Открывающаяся фигурная скобка alt + 0123 
} Закрывающаяся фигурная скобка alt + 0125 
ґ  alt + 0180 
Ґ  alt + 0165 
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Приложение 3 
 

ФОРМАТЫ БУМАГИ 

Формат Размер 
Условное 

обозначение 

Коэффициент 
перевода в учетные 

единицы 
A0 840×1189 мм  

0,93 

A1 594×840 мм 60х84 
A2 420×594 мм 60х841/2 
A3 297×420 мм 60х841/4 
A4 210×297 мм 60х841/8 
A5 148×210 мм 60х841/16 
A6 105×148 мм 60х841/32 
A7 74×105 мм 60х841/64 
A8 52×74 мм 60х841/128 
A9 37×52 мм 60х841/256 
A10 26×37 мм 60х841/512 

 
B0 1000×1414 мм  

1,30 

B1 707×1000 мм 70х100 
B2 500×707 мм 70х1001/2 
B3 353×500 мм 70х1001/4 
B4 250×353 мм 70х1001/8 
B5 176×250 мм 70х1001/16 
B6 125×176 мм 70х1001/32 
B7 88×125 мм 70х1001/64 
B8 62×88 мм 70х1001/128 
B9 44×62 мм 70х1001/256 

B10 31×44 мм 70х1001/512 

Коэффициент перевода в учетные единицы: 

..
.

луП
лП

пр
K 

 

где Пл – площадь листа (первого формата) в см2; Пу.л. = 5400 см2 



 

Для заметок 
 



112 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

____________________________________________ 
 

Компютерная верстка Е. Дорофеева. 
Подп. к печати 13.10.2011. 

Формат 60х841/16. 
Гарнитура «Times New Roman». 

Условн. печ. лист. 6,51. Уч.-изд. лист. 2,94. 


